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  PREFACE 

 

WELCOME 

Audience 
This manual assumes that you are familiar with the following: 

 General knowledge of Microsoft Internet Explorer & Microsoft 
Excel  

 The environment in which UMT Portfolio Optimizer™ is installed, 
e.g. Windows XP 

About This Book 

This user manual contains information about UMT Portfolio Optimizer™. 
It is divided into chapters that relate to the core functionality and logical 
usage of the system so you can easily find information on any feature or 
component. 

Specifically this manual covers the following areas: 

Introduction 

Chapter 1, “Overview,” briefly explains the core functionality of UMT 
Portfolio Optimizer™ and outlines its key concepts and features. 

Chapter 2, “Getting Started,” details the basic navigation through the 
application. 



Welcome 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 7  
© Copyright 2006 United Management Technologies Inc. 

 

Chapter 3, “Settings,” covers the setup of structural and relational 
attributes that define each structure and relationship. 

Portfolio Optimizer Views 

Chapter 4, “List View,” details the functionality and navigation in the List 
view. 

Chapter 5, “Data View,” details the functionality and navigation in the 
Data view. 

Chapter 6, “Relations View,” details the functionality and navigation in 
the Relations view. 

Portfolio Optimization & Analysis 

Chapter 7, “Portfolio Optimization,” provides an in-depth description of 
the optimization functions. 

Chapter 8, “Decision Dashboard,” documents how to create and analyze 
different scenarios based on the output of the optimization analyses. 

Utilities 

Chapter 9, “Exporting Data,” provides instructions on how to export data 
from the application to Microsoft Excel. 

Chapter 10, “Importing Data,” documents how to transfer data from 
Microsoft Excel worksheets directly into the UMT Portfolio Optimizer™. 

Chapter 11, “Chart Wizard,” provides a detailed description of the 
charting function. 

Chapter 12, “Portfolio Optimization,” provides an explanation of how the 
various filter types may be applied to the different views. 

 

The Appendix provides installation and setup procedures and describes 
the technical requirements and recommendations for running the UMT 
Portfolio Manager™. 

This document also contains an Index. 
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INTRODUCTION 

 

This section contains the following chapters: 

 Overview 

 Getting Started 

 Settings 

 

 

 



 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 9  
© Copyright 2006 United Management Technologies Inc. 

 

  CHAPTER 

1 
 

 

OVERVIEW 

The UMT Portfolio OptimizerTM software suite provides integrated, 
automated, web-based tools with powerful optimization logic and strong 
graphical reporting engines to assist you in optimizing IT investments 
and ensuring the continuous alignment of your portfolio with the 
company's strategy. 

Key Features of UMT 
Portfolio Optimizer™ 

The UMT Portfolio Optimizer™ empowers you to: 

 review and prioritize the drivers of your business; 

 calculate a priority score for each proposed project; 

 optimize the portfolio against multiple constraints; 

 gain insight into critical issues impacting the portfolio. 
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UMT Portfolio Optimizer™ 
Concepts 

The UMT Portfolio Optimizer can perform many functions, which are 
described throughout this guide.  This section, however, enables you to 
quickly familiarize yourself with the UMT methodology that underlies 
these functions. Cross-references are provided throughout the chapter if 
you require more information. 

The UMT Project Portfolio 
Management Methodology 

The UMT Portfolio Optimizer was conceived and based on the project 
portfolio management methodology that UMT has been developing for 
the past fifteen years. Before describing in depth the different parts of the 
application, it is essential that this methodology and the theory that lies 
beneath the software are properly understood.  

Practice has shown that an improper management of the project portfolio 
leads to financial losses and minimization of overall value. In fact, 50% of 
IT projects fail to meet objectives and over 60% of projects fail because of 
poor or inefficient management. The causes are quite simple: projects do 
not always fulfill the strategic objectives of the company, they are not 
prioritized and their benefits and constraints are not properly assessed.  

The UMT project portfolio management methodology is designed to align 
a company’s project portfolios with their business strategy and to 
optimize the portfolios against multiple constraints, such as cost and 
resources.  

The steps below outline the UMT Project Portfolio Management 
Methodology: 
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Building a Shared Vision is the first step of the process and involves 
identifying the Business Drivers of the organization. Drivers are specific, 
actionable, and measurable objectives that the organization wants to 
fulfill. Once the drivers have been defined, their relative importance is 
evaluated using pair-wise comparison. The output of the pair-wise 
comparison is a prioritized list of drivers with an assigned weight.  

Developing Projects and Initiatives is the next step of the process. This 
step captures the projects/initiatives under consideration by the 
organization. It includes understanding each initiative, recognizing 
dependencies and identifying attributes related to the initiatives, such as 
cost, resource requirements, duration, etc.  

Developing impact definitions and prioritizing the portfolio of projects 
involves evaluating the impact of each project against the organization’s 
objectives.  This is done to determine the project’s impact to the drivers, 
and to define a prioritized list of projects and initiatives. 

Analyzing and optimizing the portfolio of projects reveals the “best set” 
of initiatives for the organization. The prioritized list of projects, as 
determined in the previous step, is confronted with different constraints, 
such as cost, resources, or “must do” initiatives. The different scenarios 
that are created must be analyzed so that the best solution for the 
organization is determined.  

The “must do” initiatives are projects that will be forced into the solution 
when management considers that these are projects that will be done 
under all circumstances. An example could be developing an accounting 
software or improving the existing infrastructure. Even though these 
projects could have a high cost and a low value, they can be considered 
essential to the company’s future development or can have a high future 
value. 

The Portfolio Scheduling and the Portfolio Tracking processes complete 
the project portfolio management methodology. Once the optimal 
portfolio of projects has been identified, the next step is to schedule these 
projects to achieve the greatest business value while meeting obligations 
for “must do” projects.  This is accomplished using the UMT Portfolio 
Planner. The Portfolio Tracking step involves the ongoing monitoring of 
the selected initiatives and recognition of proposed new initiatives. The 
Portfolio Dashboard component of UMT supports this step. 
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Overview of the UMT 
Framework 

Before describing the framework in depth, we should take a closer look at 
the process steps involved in using UMT’s Portfolio Optimizer and how 
they relate to the methodology steps described above.  

The first step of the process involves defining a new Portfolio Optimizer 
portfolio of projects. This portfolio is then populated with the predetermined 
business drivers and initiatives, for which structural attributes are 
defined. These attributes will be used as inputs to the scenario analysis. 
The final step corresponds to the prioritization and optimization of the 
project portfolio.  

By using relative importance and impact matrices, pair-wise comparison is 
performed and then combined with the project/driver impact for 
prioritization. The optimization can then be performed and the scenarios 
that are calculated can be assessed for the best solution.  

Following the project portfolio optimization, additional analysis is 
undertaken to fully understand the business implications of the different 
scenarios reviewed during the optimization process. 

Associated with each entry are a number of structural attributes. There are 
5 types: text, real, integer, string and date. The structural attributes can 
contain numeric data, dates or textual information relating to a specific 
entry. Below, you can see a list of possible structural attributes that may 
be used.  

The list is not comprehensive; it gives a hint to the structural attributes 
that may be used: 

• Cost is generally defined as a real number attribute and can be 
used to express the total estimated cost of a project. 

• FTE (Full Time Employee) is generally defined either as a real 
number or an integer and represents the human resources you 
estimate a project will use. 
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• Start/End Dates are date-type attributes. If you define such 
attributes, they can express the estimated start date and end date 
of a project. 

• Department can be defined as a string-type attribute, with up to 
20 alphanumerical characters and can be used to show which 
division or department the projects belongs. 

• Risk is generally defined as a text attribute with 3 or 4 values and 
shows the estimated risk of each project. 

The structures are linked by relationships, described by one or more 
relational attributes. The relations between structures are used to reflect the 
fact that entries in different structures, as well as those in the same 
structure, influence each other and may have an impact on each other.  

The relational attribute values are updated in the Relations View. Most 
often three types of relational attributes are used: Relative Importance, 
Impact and Dependency. 

• Relative Importance is generally used to describe a relationship 
between one structure entry and another entry within the same 
structure, most often a Drivers vs Drivers relation. It is used as a 
symmetric attribute; an attribute may be set to a symmetric 
attribute when defining the attribute in Structure and Relations. 

• Impact is used to define the relationship between two different 
structures. Most often, it is meant to reflect how each of the 
projects from the portfolio affects the drivers (objectives) the 
organization has defined.  

• Dependency is an attribute that is generally defined for projects 
and project relationships. It describes how the projects from the 
portfolio interconnect to each other. For example, when one 
project depends on another project, both must be handled as a 
single project during analysis.  

Another example of a dependency is when selection of one 
project might exclude another. By doing Project A, you do not 
have to do Project B anymore, as they accomplish similar goals. 
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  CHAPTER 

2 
 

 

GETTING STARTED 

Logging on 

To access the Portfolio Optimizer™  module, the first thing to do is to log 
on the UMT Portfolio Manager™, where the projects and their 
corresponding information are stored. For this, you must know the 
account name, the account password, your username, and your 
password. Contact your system administrator to obtain this information.   

Your system administrator will also provide a specific URL for the UMT 
Portfolio Manager™ web-site.  When you access the UMT Portfolio 
Manager™ web-site, you will see the following screen: 

 
Figure 2-1 Account Login 

Type in the account name and account password and then click Login. 
Please note that passwords are case sensitive; account names are not. 
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Next, you will see the following dialog box: 

 
Figure 2-2 User Login 

Type in your user name (not case sensitive) and password (case sensitive) 
then click Login.   

The next screen will present a list with all the projects in your portfolio, 
within the UMT Portfolio Builder™ module. The way projects are entered 
into this module is presented in the UMT Portfolio Builder™ manual.  

 
Figure 2-3 Project List Screen 
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To be able to use the UMT Portfolio Optimizer™, first select the level 
within the organization or the custome portfolio you want to evaluate.  
Then, click the “Optimizer” link placed on the navigation toolbar at the top 
of the screen, and you will be directed to the UMT Portfolio Optimizer™  
main view. 

Basic Navigation in the UMT 
Portfolio Optimizer™  

The main panel (Figure 2-4) contains a graphical presentation of the 
relationships between the structures, and a navigational toolbar at the top 
of the screen.  

 
Figure 2-4 Portfolio Optimizer™ Main View 

The UMT Portfolio Optimizer™ provides the ability to work with 
portfolios of projects, programs and applications.  By selecting the entity 
in the Entity drop-down menu, the appropriate route map is displayed.  
This manual explains usage of the UMT Portfolio Optimizer™ for project 
portfolio management. 

In order to navigate in the different Features of the Optimizer™, click the 
desired link in the graphical presentation or the toolbar placed at the top 
of the screen (Figure 2-5).  
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Figure 2-5 Portfolio Optimizer™ Toolbar 

The features remain at the top-right of the screen, and they allow you to 
navigate between different sections of the module. Their details are 
presented below. 

Option Description 

Edit Displays options to edit the list of structures (Projects or 
Drivers), the data within the structures, or the relationship 
between them. 

Analyze  Accesses the feature where optimization analyses are 
being conducted.  

Chart  Accesses the Chart Wizard, where various graphs and 
charts can be designed and displayed. 

Select  Loads the Decision Dashboard, where further analysis of 
different solutions for the portfolio that have been created 
in the Analyzer may be conducted. 

Log out  Ends your Portfolio Optimizer™ session and takes you out 
of the account you had been using  

After completing your session in the UMT Portfolio Optimizer™, use the 
Builder link in order to return to the UMT Portfolio Builder™.  

Note: Always use the Log Out button (located in the toolbar) when you 
are leaving the UMT Portfolio Optimizer™ rather than closing the 
browser window 
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  CHAPTER 

3 
 

 

SETTINGS 

General Overview 

The Settings feature is common to all the modules in the UMT Portfolio 
Manager™ and is presented in details in the Settings guide of the UMT 
Portfolio Manager™. Therefore, it is assumed that the user is familiar 
with that feature, and only overview of the specific settings pertinent to 
the UMT Portfolio Optimizer™ are provided in the pages that follow. 

Attribute Definition 

This functionality allows you to define additional attributes for Projects or 
Business Drivers.  These attributes will then appear associated with the 
structures when using the different features of the UMT Portfolio 
Optimizer™ - List View (List/Data), Data View (Edit/Data) or Analyzer 
– or with the relation between structures – Relations View (Relations) as 
in the case of Relative Importance for the relation between Drivers or 
Impact for the one between Projects and Drivers.   

The Project and Drivers attributes can then be used for: 

• Running optimization analyses and using different Project 
attributes as constraints or on different assumptions about the 
Business Drivers’ ranking. 



Settings 

 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 19  
© Copyright 2006 United Management Technologies Inc. 

 

• Saving the results of the optimization analyses as values of the 
attributes and building charts and graphs with them. More details 
on how to create charts are given in Chapter 11. 

• Defining filters:  one of the options for defining filters is to use 
Project or Drivers attributes.  For example, you can create a filter 
which includes only the projects where the NPV attribute has a 
value higher than a certain threshold.  For more details on how to 
create and use filters, please refer to Chapter 12 of this User 
Manual. 

To access the Attribute Definition function, use the link provided in the 
Settings page, from the UMT Portfolio Builder™ module.  

Select the Add Attribute option, and select the UMT Portfolio 
Optimizer™  from the Application Usage pane (top-left corner in Figure 
3-1) . Then, set the Attribute Type, Attribute Category, and Attribute 
Entity.  

Creating New Attributes  

To create a new attribute, introduce data in all the requested fields in 
Figure 3-1, select the attribute type and click Add Attribute: 
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Figure 3-1 Attributes Definition Screen 

There are several Attribute Types that can be defined and used in the 
UMT Portfolio Optimizer™ module. 

There are six types of attributes that can be added – list, real, integer, date, 
string and multiple-text – each of them being presented in detail in the 
Settings guide for the UMT Portfolio Manager™.  

After creating the Attribute, in order to see it in one of the UMT Portfolio 
Optimizer™ sections, the final step should be to associate it to the 
portfolio of projects you use in the UMT Portfolio Optimizer™ module.  

Complete details about attribute management is provided in the Settings 
guide of the UMT Portfolio Manager™. 

Modifying Attributes 

To modify an existing attribute, select it from the list and click Edit.  The 
same screen as for creating attributes will be displayed, but now the 
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Entity and Type selection lists will be disabled since you cannot modify 
them once the attribute has been defined.   

Deleting Attributes 

To delete an attribute, select it from the list and click Delete.  A dialog box 
will pop up, where you can confirm or cancel the deletion. 

 

Prerequisites 

In order to perform project portfolio analysis the following structures are 
necessary: 

• Projects 

• Business Drivers 

In order to perform program portfolio analysis the following structures 
are necessary: 

• Programs 

• Business Drivers 

In order to perform application portfolio analysis the following structures 
are necessary: 

• Applications 

• Business Drivers 

• Business Processes 
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• Architecture Drivers 

Complete details about management of these structures is provided in the 
Settings guide of the UMT Portfolio Manager™. 
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UMT PORTFOLIO OPTIMIZER™ VIEWS 

 

This section contains the following chapters: 

 List View (Edit/List) 

 Data View (Edit/Data) 

 Relations View (Edit/Relations) 
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  CHAPTER 

4 
 

 

LIST VIEW (EDIT/LIST) 

List View 

General Overview  

The List View’s main function is to list all projects or drivers that will be 
used for the portfolio analysis. 

The List View also allows changing the project or driver name. 

Opening the List View will bring you to a screen listing the projects or the 
drivers.  

 
Figure 4-1 List View (Edit/List) 
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Each entry has an Entry ID, a Short Name and a Long Name. You can 
use the toggle button from the toolbar to switch between the Short Name 
and Long Name display. By default, the Long Names are displayed here. 

Select an entry and use the one of the following buttons to perform 
operations on the entry: 

• Insert Entry allows you to insert a new entry in the same 
portfolio. 

• Delete Entries will delete the entries that you have selected. 

• Edit Menu allows you to change the entry name 

Click on the Import Wizard button if you want to import entries in the 
portfolio (please refer to the UMT Portfolio Builder™ for detailed 
description of the Import Wizard).   

Click on the Save Data button to save your changes.  

Working with Element Views 

If you select the Edit Entry option from the Edit Menu button the element 
view window will be displayed for the selected entry.  

Title - this tab (Figure 4-2) is used to modify the entry’s long name, short 
name and custom ID. 

 

 
Figure 4-2 Element View - Title 

On the tab right hand side, there are several additional options: 

Hide button is used to close the Element View dialog box. 
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New Entry has the functionality that has been described above. 

The Apply button records the changes.  

 

List View Toolbar 

The List View toolbar (Figure 4-3) contains the following options: 

 
Figure 4-3 List View Toolbar 

 

Button Description 

 

 

The Edit Menu contains the following options: 

• Edit entry - opens the Element View dialog 
box; 

• Show Custom ID – Custom ID is a user-
assigned ID to each entry; 

• Show ESF ID – ESF ID is an internally 
assigned ID to each entry; 

• Copy to clipboard - allows you to copy the 
list of entries that you can paste into an 
Excel worksheet.  

 
The Delete button deletes the group of entries 
selected.  
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Button Description 

 
The Insert Entry button inserts a new entry in the 
same portfolio. 

 

The Filters Bar displays the filtering options from 
where you can choose the filter(s) you want to 
apply or you can define new filters for the structure 
through the Filter Wizard. See Chapter 12 - “Filter 
Wizard” for further details. 

 

The Long Names/Short Names button toggles 
between the short names and long names of the 
entries. 

 

The Select All switch selects or unselects all entries 
at once. 

 

The Import button allows you to import entries 
from an Excel worksheet. See Chapter 10 - 
“Importing Data” for further details. 

 
Data can be saved if you click the Save button.   

 

You can exit the List View without making any 
changes if you click the Close button. However, you 
will be prompted to save if you have made any 
changes to your work. 
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  CHAPTER 

5 
 

 

DATA VIEW (EDIT/DATA) 

This section of the User’s Guide will teach you how to edit an entry’s 
structural attributes. In order to proceed, enter the Data View (Edit/Data) 
feature of the module. 

General Overview 

The screen presented will provide a table with two main sections. On the 
left side, you can see a list of the entries (projects or drivers) for the 
selected portfolio (Projects in Figure 5-1).  

This list includes two columns: the first column contains the ESF ID of the 
entries and the second one shows their short names.  

The right side, starting with the third column, displays the structural 
attributes. The rows provide the value of the structural attribute for each 
individual entry (while the attribute’s name is shown in the column 
header). 
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Figure 5-1 Data View (Edit/Data) 

There may be some cells that can’t be edited.  For example, when the 
project is already Approved or In Implementation stages of the 
Workflow process, or when the attribute is a calculated attribute. 

Find below some examples of structural attributes:  

• Cost – represents the project’s cost; it is defined as a real 
numerical attribute, rounded to the nearest whole dollar, and its 
value will be taken from the Cost section of the Project, in the 
Portfolio Builder™ module. 

• Scaled Overall Risk – this is a list attribute, with the values 
None, Low, Medium or High. The value is derived form the risk 
score calculated in the Risk tab of the Portfolio Builder™ module. 

• Priority – the importance of a certain entry for that structure (a 
project or a driver), obtained after conducting a prioritization 
analysis. It is expressed in numbers - 0.022077 or 0.21885 or 
percentage – 2.2077% or 21.8850%. The highest number represents 
the most important entry of the structure.  

• Start/End Date – this is the start/finish date of the project.  
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Working with the Data View 

In order to edit a cell, double-click it and enter the desired value. The 
entered value must be of the same type as the attribute – i.e. you cannot 
enter text in a cell belonging to a real or integer attribute.   

Note: The value entered also has to be in the range of values defined for the 
attribute. 

After entering values for attributes, you must click the Save Data button 
(top-right part of the screen in Figure 5-1). In the case you forget to do so, 
a message will prompt you to save your changes on exiting the Data 
View. 

Data View Menu 

The data view menu is accessed by right clicking the spreadsheet cells - 
Figure 5-2. The menu provides access to a number of functions for editing 
the cells and the data layout.  

 
Figure 5-2 Data View - Right-click Menu 
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Cut, Copy, Paste - these are basic options that help you in editing the 
spreadsheet by reusing data that has already been entered. 

Comments - you can add comments for each cell that may describe or 
explain the values that you have set for the attributes. The options here 
are Add, View, Delete or Delete All Comments.  

Setting the row and column dimension (Figure 5-3) – the width or height 
of cells can be modified in this way. Enter the dimension for the cell and 
select your option by choosing the appropriate radio button. 

 
Figure 5-3 Data View - Setting the Cells' Dimensions 

 
Sort - sorting can be done in either ascending or descending order, by the 
entire column or by the selection of cells chosen. To rearrange the entries 
by their IDs, select Clear Sorting from the same menu. 

Data View Toolbar 

The Data View toolbar provides a set of options that are very useful when 
working with the Data View (Figure 5-4). 

 
Figure 5-4 Data View Toolbar 

The toolbar contains the following options: 
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Button Description 

 

The File Menu allows you to save the spreadsheet 
as an Excel worksheet on your computer, print it, 
or send it by e-mail. 

 

The Zoom option allows you to resize the 
spreadsheet table from 25% to 200%. Or, you can 
choose to see the table fit in the screen. 

 

 

The two switches located near the Zoom selection 
box bring up the Formula or the Filters Bar (both 
bars cannot be visible at the same time). They will 
be presented later in this chapter. 

 

The Import Wizard button allows you to import 
data from an Excel worksheet. This option will be 
presented in Chapter 10 - “Importing Data”. 

 

 
Data can be saved if you click the Save button. 

 

You can exit the Data View without making any 
changes by clicking Close; however, you will be 
prompted to save if you have made any changes to 
your work. 
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The Formula Bar 

Using the Formula Bar (Figure 5-5) allows you to make calculations in 
your spreadsheet cells using four basic functions: 

• Sum - calculates the sum of the values in the selection of cells; 

• Average - indicates the average value of the values in the 
selection of cells; 

• Min and Max - returns the minimum or maximum value in the 
selection of cells. 

To access these operations click the switch in the Spreadsheet toolbar. 

 
Figure 5-5 Data View - Formula Bar 

 
Select the cells where the formula will be applied, but make sure your 
selection does not contain more than one column (as these operations are 
related to a single structural attribute).  

Then select the desired function, click Calculate Formula and the result 
will be displayed. To apply the result to a cell in the spreadsheet, select it 
and click Apply Result.  

These formulas can only be applied on real and integer attributes. They 
will not calculate anything for other structural attribute types (date or list 
type attributes). 

The Filters Bar 

There are two types of filters that can be used in the Data View – 
Structure Filters and Attribute Filters.  

The first type, Structure Filters, concerns structure entries; it hides the 
rows with the structure entries (projects, drivers) that do not meet the 
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filter’s definition criteria.  The management of these filters is made using 
the Filter Wizard (the procedure will be detailed in Chapter 12). 

The second type - Attribute Filters - is particular to the Data View 
(Edit/Data). They filter the columns by hiding the attributes that you 
don’t need to use for your current session, and only display the ones that 
are included in the filter. 

To access the Filters Bar, click the switch with the same label in the Data 
View toolbar (Figure 5-4) and it will become visible. 

 
Figure 5-6 Data View - Filters Bar 

To apply a filter, select it from the appropriate selection box placed on the 
toolbar (Figure 5-6), click the Structure or Attribute filter button (a popup 
menu will appear), select a filter and click Apply filter.  

The definition and maintenance of Attribute Filters can be done in the 
Data View, in the following manner: click the Attribute Filters button 
and select Define New Filter from the popup menu that appears (Figure 
5-7). 

 
Figure 5-7 Attribute Filter Menu 

The new window that is displayed (Figure 5-8) presents two lists. The one 
on the left side, labeled Structure attributes, contains all attributes 
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associated with your portfolio; the one on the right side (labeled Visible 
attributes) is empty at the beginning.  

Select an attribute in the Structure attributes list, then click the arrow 
pointing to the other list (you can also ‘drag and drop’ it to the other list 
with the mouse or double click on the attribute).  

To remove an attribute from the filter, select it from the Visible attributes 
list and click the arrow pointing to the Structure attributes list (you can 
also ‘drag and drop’ it to the other list with the mouse or double click on 
the attribute). 

 
Figure 5-8 Attribute Filter Wizard 

To save the filter, enter a name in the edit box labeled Attributes filter 
name (top section of the Figure 5-8), and then click Save (this is disabled 
if no name is entered).  

Note:  Only saved filters can be applied. 
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  CHAPTER 

6 
 

 

RELATIONS VIEW (EDIT/RELATIONS) 

General Overview 

The Relations View enables you to see the relationships between entries, 
either within the same structure or in different structures. The Relations 
View is where you populate the relational attributes to best describe the 
relationship between structure entries.  

The number of rows and columns depends on how many entries there are 
in the structures you have selected. The view is limited to a maximum of 
255 columns. In the first column are the IDs of the entries belonging to the 
row structure. The next column shows the short names of these entries. 
Starting with the third column you can see the entries from the second 
structure (ID in the top row, name in the second row).   

A systemic matrix is used to describe a systemic relation, which is a 
relationship between a structure entry (Business Driver) and another 
entry in the same structure (another Business Driver). In practice, this 
type of relation is typically used either for a Drivers-to-Drivers relation 
(with a Relative Importance attribute to define it) or on a Project-to-
Project relation (with a Dependency relational attribute).  

In Figure 6-1, a symmetric matrix, describing a Drivers-to-Drivers 
relation, is presented. As you can see, such a matrix is defined only by the 
elements above the main diagonal.  

This is because a relation between an entry and itself cannot be defined – 
these are the cells on the main diagonal. Also, the relation between two 
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different entries has a cell below the diagonal that corresponds to one 
above.  

Since these relations are the inverse of the values above the diagonal (i.e. 
if it says “extremely more important” above the diagonal, the relation is 
“extremely less important” in the corresponding cell below the diagonal), 
the cells below the main diagonal are not editable.  

As shown in the following figure, a systemic matrix expresses the relation 
between the entry on the row structure and the entry on the column 
structure.  

Note: This example shows that the “Reduce delivery time” entry is Strongly 
More Important than the “Increase number of new accounts” entry.  

 
Figure 6-1 Relations View (Edit/Relations) - Systemic Matrix 

A non-systemic matrix describes the relation between two entries that 
belong to different structures.  

Such a matrix can be seen, for example, on a Projects-to-Drivers relation 
with an Impact relational attribute. As you can see from Figure 6-2, for a 
non-systemic matrix, all of the values can be completed. 

Systemic  matrices (e.g. Driver pairwise comparison, Project 
dependencies) are saved per organization whereas non-systemic matrices 
(e.g. Project to Driver impact) are saved at the account level. 

The Project to Driver impact matrix is linked to the UMT Portfolio 
Builder™ Strategic Impact tab. 
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Figure 6-2 Relations View (Edit/Relations) – Non-Systemic Matrix 

In this example, the entry on the row structure “Database Migration” has 
a Strong impact on the entry on the column structure “Reduce delivery 
time.”
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Working with the Relations 
View 

The Relations Menu 

As discussed, the Relations View is used to assess values for the 
attributes describing relationships between entries. To enter data in the 
Relations View, left-click a cell to open a menu with the options that have 
been defined in the Attribute Definition section for each attribute.  

Select the chosen value to describe how the row structure entry affects the 
column structure entry. 

Right-click a cell to open a menu that allows you to perform basic 
operations such as adding, viewing or deleting comments, cut, copy and 
paste or sorting. 
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Figure 6-3 Relations View – Right-click Menu 

• Cut, Copy, Paste - these are basic options that help you in 
completing the spreadsheet by reusing data that has already been 
entered. 

• Comments - you can add comments for each cell that may 
describe or explain the values that you have set for the attributes. 
The options here are Add, View, Delete or Delete All 
Comments.  

• Setting the row and column dimension – the width or height of 
cells can be modified if using this option. Enter the dimension for 
the cell and select your option by choosing the appropriate radio 
button in the dialog box (Figure 6-4), which is displayed when 
selecting one of the two options. 
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Figure 6-4 Relations View - Setting the Cells' Dimensions 

• Sort - sorting can be done in either ascending or descending 
order, for the column or for the row structure. Additionally, you 
have the option of sorting by selection.  

This type of sorting does not necessarily sort ascending or 
descending. Instead, it gives you an idea about which projects 
have a substantial impact on the drivers. Conversely, it can show 
you that some projects have no impact or little impact on the 
drivers.  

Note: This type of sorting will group together the projects with similar 
impact. It can be useful to gain a general overview of your portfolio and 
its interaction with the objectives. 

 

The Relations View Toolbar 

The Relations View toolbar (Figure 6-5) gives the possibility of 
conducting several operations, detailed below. 

 
Figure 6-5 Relations View Toolbar 

The toolbar contains the following options: 
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Button Description 

 

The File Menu allows you to save the matrix as an 
Excel worksheet, print it, or send it by e-mail. 

 
You can switch between the relational attributes 
available by opening this drop-down menu.  

 

Swap Matrix button transposes the matrix. For 
example, if the entries from the Projects structure 
are displayed in columns and entries from the 
Drivers structure are displayed in rows, click the 
swap matrix button to switch their position by 
showing the Projects entries in rows and Drivers in 
columns. 

  

The Filters Bar displays the filter bar from where 
you can choose the filter(s) you want to apply or 
you can define new filters for the structure through 
the Filter Wizard. See Chapter 12 - “Filter Wizard” - 
for further details. 

 

The Import Wizard button allows you to import 
data from an Excel worksheet. This will be 
discussed in detail in Chapter 10 - “Importing 
Data”. 

 
Data can be saved by clicking the Save button.  

 

You can exit Relations View without making any 
changes by clicking the Close button. However, you 
will be prompted to save if you have made any 
changes to your work. 
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The Filter Bar 

Defining new filters will be detailed in the Chapter 12 - Filter Wizard; 
here we will have a quick look at using filters in a Relations View.  

We will use a non-systemic matrix of Drivers and Projects as an example. 
To apply a filter on one of the structures, use the Filters Bar Switch on the 
Relations view toolbar (Figure 6-5), and the Filters Bar is displayed 
(Figure 6-6). 

 
Figure 6-6 Relations View - Filters Bar 

The Filters Bar shows the filters that have been defined for each structure 
in a separate drop-down menu. After selecting one or both filters, click 
the Filters Menu button.  

 
Figure 6-7 Relations View - Filters Menu 

The menu displayed (Figure 6-7) is the same as the one in List (Edit/List) 
or Data (Edit/Data) View, except that here there are 2 structures and each 
option in the menu can be used for both structures. 

 The application of a filter on a selected structure (for example, Drivers) 
will only filter entries from the respective structure. 
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PORTFOLIO OPTIMIZATION & ANALYSIS 

 

This section contains the following chapters: 

 Portfolio Optimization 

 Decision Dashboard 
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  CHAPTER 

7 
 

 

PORTFOLIO OPTIMIZATION 

General Overview 

The Optimizer helps you select the projects and allocate the resources that 
best serve your organization’s objectives. The analysis accounts for real-
world constraints such as funding, physical plant capacity and trained 
personnel.  

The Optimizer helps you identify, prioritize, communicate, and value the 
needs of the projects that are the most important for your business. 

The Optimizer General 
Overview 

To run an optimization analysis, the relations between the Drivers and 
Projects structures have to be established (for the portfolio the analysis is 
being conducted on).  

At least one structure, usually Drivers, is related to itself through a 
systemic pair-wise relation (using a symmetric attribute such as Relative 
Importance, with values such as Extremely more important, balanced by 
their opposite - for example Extremely less important).   
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Projects may be related to Drivers by their Impact, for example, with the 
values: Extreme, Strong, Moderate, Low and None.  

In brief, the Optimizer process works as follows: 

• Compare every driver to every other driver to create a ranked 
Drivers list. 

• Determine the impact of projects on drivers to create a ranked 
Projects list. 

• Identify attributes to use as constraints (e.g. cost, FTEs, NPV) to 
optimize the structure entries. 

The following list consists of terms frequently used in the Optimizer 
displays and reports, or when discussing an optimization process. 

Term Definition 

Analysis A group of optimization solutions that use the same 
structures and relations. 

Solution This refers to a specific result of an optimization 
problem using the matrix values that you entered; a 
given set of constraints and values, and a specific 
Limit Vector. 

Limit Vector A set of cut off values that represent the maximum 
number of allocated resources. For example, if 
person-years and investment cost are the constraints, 
50 person-years and $5 million may be the Limit 
Vector for a particular solution.  

Weights Prioritization weights are the calculated values 
representing the relative importance of a particular 
entry in any structure included in the analysis. The 
sum of all the priorities for a structure will be 1 (or 
100 if choosing Display as percent). 

Efficient Frontier A graph that shows a family of solutions for 
different values of one constraint plotted against an 
objective function (usually the strategic value of the 
solution). The objective function expresses the value 
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Term Definition 
of the projects that can be included and, thus, 
indicates the maximum benefit that is derived from 
different levels of investment. 

Consistency Ratio A coefficient indicating the consistency of the driver 
rankings. This value runs from 0 to 100% and 
should be below 20%. A high Consistency Ratio 
means there are many inconsistent driver-to-driver 
comparisons.  

Required Data 

 The minimum requirements to run the Optimizer are: 

• A list of Business Drivers (objectives, goals). 

• A list of Projects (initiatives). 

• A value for at least one constraint for each project (such as Cost or 
FTE). 

• A limit value for each constraint type, such as budget for Cost, or 
total available resources for FTE. 

• A description of the dependencies between projects, if any. The 
dependencies should be defined in the Project - Project Dependency 
matrix as follows: for each pair of projects, if there is a 
dependency, use the following values: 

Value Definition 

Excludes If one entry is included, the other entry is not. For 
example, if two items are “Commit to Coal-Based 
Energy” versus “Convert to Atomic Energy”, they 
may be mutually exclusive. 

<Depends The column item depends on the row item.  The 
item in the column cannot be included if the item 
in the row is not included. 
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Value Definition 

Depends^ The row item depends on the column item. The 
item in the row cannot be included if the item in 
the column is not included. 

<Depends^ The items are mutually inclusive. Neither of the 
items can be included alone. They are either both 
included, or both excluded. 

None There is no connection (dependency) between the 
two items. 
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Using the Optimizer  

To run an optimization analysis, use the Optimizer link on the Portfolio 
Actions toolbar (Figure 2-4) to access the UMT Optimizer™ module and 
then click on the Analyze link on the UMT Portfolio Optimizer™ toolbar 
(Figure 2-5).  

Optimizer Open Dialog  

The screen presents two options, creating a new analysis or opening an 
already existing one. Each option can be accessed by clicking the 
appropriate tab. 

 
Figure 7-1 Optimizer Create New Analysis 
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Create New Analysis  

Selecting the Create New Analysis tab displays the Optimizer Open 
Dialog (Figure 7-1) section. You can choose the relational attributes that 
will be used in the optimization process and the filters applied on each 
structure.  

The list displayed contains the two structures – Drivers and Projects. 
Next, select an existing matrix that suits your needs from the drop-down 
list (if the one displayed is not the one you want to use).  

If you want to work with a subset of entries, you can select a filter, 
assuming there is a filter defined (to define a new filter, go to List View,  
Data View or Relations View, or go to Filter Management in the 
Settings area of the Builder). 

Note: The settings that can be changed here will be presented later in this 
chapter. 

Then select the New analysis radio button from the list on the right side 
of the screen (if it is not already checked) and click Go to. This action will 
start the process of creating a new analysis. 

Besides the creation of new analysis, this screen allows you to define 
Project Alternatives and Project Dependencies, by selecting the 
appropriate radio button and using the Go to button. 

Project Alternatives  

The Alternatives are groups of structure entries that are mutually 
exclusive. Assume that you have three projects from which you have to 
choose only one, as they provide the same benefits for your organization. 

You can include all of them in your analysis. To do so, define an 
alternative containing all of them. When using this alternative, the solution 
computed by the Optimizer will choose only one of the three projects 
included in your alternative, even if there are enough resources to include 
the other ones as well. 
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To enter the definition section for Alternatives, select the Project 
alternatives radio button that is placed below the New Analysis button in 
Figure 7-1, on the right side of the screen, and use the Go to button.  

A new screen will be displayed, as in Figure 7-2. 

 
Figure 7-2 Alternatives Setup Screen 

The procedure of defining an alternative is very simple. First click the 
Add new button in the top section of Figure 7-2. A dialog box will appear 
requesting you to enter the name for the new alternative, and some 
comments regarding it (comments are optional).  

Then, the two arrows between the Structure entries list and the 
Alternative entries list become enabled. Select the entries that you want 
to include in the alternative from the Structure entries list and click the >> 
arrow (drag and drop is also possible).  

They will be placed into the second list, on the right side of the screen, 
labeled Alternatives entries. To remove an entry from the Alternatives 
list, select it and use the other << arrow.  
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Save your alternative using the Save button, placed at the top of the 
screen. Alternatives can also be deleted by selecting them from the drop-
down list and using the Delete button.  

When you finish managing the alternatives, click the Close button and the 
Optimizer Open Dialog is displayed. 

The Alternatives can be viewed as more complex exclusion relations 
between projects.  It is simpler to use this function as opposed to defining 
multiple project dependencies. 

Project Dependencies  

Dependencies between projects are defined and saved as values of the 
relational attribute Dependency. This functionality was presented earlier 
in the Relations View chapter and may be used when creating a new 
analysis and computing a new solution. 

To define the dependencies between structure entries, load the 
Dependencies matrix, Figure 7-3 (this can be either done by selecting the 
Project dependencies radio button below the Project alternatives and 
clicking Go to, or by directly loading the Projects-Projects matrix – 
Relations/Projects-Projects - from the Optimizer toolbar Figure 2-5).  

A filter may be used to refine the list of projects to evaluate.  Then, the 
UMT Portfolio Optimizer™ will load the Relations view for the structure 
that is related through this attribute.  
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Figure 7-3 Project Dependencies Matrix 

After updating the relations between projects, save your data and close 
the view. 

Open Existing Analysis  

You may want to open an already existing solution rather than creating 
one of your own. To do that, select Open Existing Solution tab from the 
Optimizer Open Dialog (this screen is loaded by default when you enter 
the optimization module, if one exists).  

The screen that is displayed (Figure 7-4) presents several options. 
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Figure 7-4 Optimizer Open Dialog – Existing Solutions 

In order to load an entire analysis, select it and click Load. If you want to 
load the analysis alone (just the structures that compose the already 
prioritized portfolio), without any solutions associated with it, uncheck 
the Load all solutions in analysis option (bottom of the screen in Figure 
7-4).  

If you want to Load all Solutions/Efficient frontiers associated with the 
selected analysis, make sure the two options are checked. 

To load a single solution, select it and use Load. You can also run 
Advanced analysis – Sensitivity, or Insight – on one of the saved 
solutions. Sensitivity and Insight analyses are only enabled if you select a 
solution, as they are only available at the solution level. 

You can load Project alternatives and dependencies from this page as 
well; the procedure was described in the previous sections of this chapter. 

The legend in the top-right section of the screen presents the symbols 
(icons) used for each type of analysis or solution that may be found in the 
list, so you have a clear image of what is available for loading. 
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Optimization Process Steps  

The Business Drivers Matrix 

When creating a new analysis, the first step would be the completion of 
the first Importance Matrix. This matrix (Figure 7-5) links the Business 
Drivers structure with itself.  

 
Figure 7-5 Optimizer Analysis - Drivers/Drivers Matrix 

As this is a systemic matrix, only the cells above the diagonal will be 
active.  

In order to proceed to the next step, you have to complete this matrix 
entirely.  

Note: By default, the application will load the data defined and saved in the 
Relations View, under the relational attribute Relative Importance.  
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Optimizer Matrix Toolbar Options 

The toolbar (Figure 7-6) presents several operations that may be 
performed in the optimization process. 

 
Figure 7-6 Optimizer Analysis - Toolbar 

Each option on the toolbar is presented in the table below: 

Button Description 

 

Using the file menu, you can export the data to an 
Excel worksheet, print or send by mail the matrix or 
the chart displayed on this page.  

 

 

This section of the toolbar is related to the 
navigation between different optimization steps, 
which will be detailed later in this chapter.  

 

By using this option you can load a different matrix 
to use in your analysis, from the ones you have 
saved before in the Relations view, using other 
relational attributes. You can also select to load just 
a subset of the values in the matrix (for example just 
the Strongly More Important values). 

 

Allows you to save the matrix displayed here by 
creating a new relational attribute in the account, or 
by overwriting an existing one. 

 
Allows you to change the settings of the analysis. 

 

Starts the Chart Wizard, where you can generate 
different graphs and charts which can help you in 
the decision making process of completing the 
Importance matrix. 



Portfolio Optimization 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 57  
© Copyright 2006 United Management Technologies Inc. 

 

Button Description 

 
This button enables and disables the hints that help 
you read the matrix data. 

 

The chart presenting the priorities of the structure 
entries can be hidden or made visible. In the first 
step of the analysis it will be disabled, as no 
priorities have been computed yet. When the chart 
is visible, the label on this button is Hide Chart. 

 

Using this selection list, you can adjust the size of 
the table in a range from 25% up to 200%. You can 
also choose the Fit option in the list, and the entire 
matrix will be made visible. 

 
Terminates the current optimization process. 

After filling in all the values in the matrix, click the Next Step button on 
the toolbar and it will take you to the following step in the process. 

Note: Once the matrix is completely filled in, it is often helpful to use the Save 
Matrix option.  This will make later retrieval of the matrix data easier. 

 

Business Drivers Weights Display 

The next step shows you the weights calculated for each entry – each 
represents the relative importance compared to the other entries (the sum 
of the values for all structure entries is always 1.0, or 100%).  

They are sorted from the most important to the least, with the entry at the 
top of the list in Figure 7-7 being the most important.  
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Figure 7-7 Optimizer Analysis - Drivers Ranking List 

Next to the table presenting the priorities, there is a chart that helps to 
better visualize the ranking of the Business Drivers (Figure 7-8). 

 
Figure 7-8 Optimizer Analysis - Drivers Ranking Chart 

The toolbar present in this screen includes the same options as the 
previous one, with the addition of the Weights Menu button.  
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Clicking it will display a menu with several options - Figure 7-9. 

 
Figure 7-9 Optimizer Analysis - Weights Menu 

 
Menu Item Description 

 Validation The structure entries that have priority zero will be 
picked from the list and presented in a dialog, 
where you can choose to exclude them from the 
current analysis or keep them in.  

 Load from 
Structure 
Attribute 

Shows a dialog with all the real and integer 
attributes linked to the current structure. You can 
pick one and it will be computed in relative terms 
(Normalized) and displayed as weights for your 
analysis, replacing the weights computed using the 
Importance matrix. 
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Menu Item Description 

 

 Load from 
Multiple 

Attributes 

Allows you to transform a combination of two or 
more numerical attributes into weights for your 
analysis.  

Note: This will be described in detail in the following 
section. 

 Remove 
Entries 

The next option in this menu - Remove Entries 
from Analysis – removes one by one the entries in 
the list, starting with the last one (the one with the 
lowest priority) and recalculates the priorities for 
the remaining ones (so as their sum remains 1.00). 

 Save as 
Attribute… 

To save a set of priorities as a Structural Attribute, 
use this option.  

 
The next three options allow you to copy the values 
in the spreadsheet to clipboard.  

You can save either the absolute values, or the 
relative ones, by selection or by entire sheet 

 
The last section of this menu allows you to set the 
dimensions of the spreadsheet – the Column Width 
or the Row Height. 
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Load from Multiple Attributes 

The third option in the list -  Load from Multiple Attributes - does the 
same thing as the second one, the only difference being that you can use 
multiple attributes (as a combination of two or more numerical attributes) 
to be transformed into weights for your analysis.  

In the first screen that appears (Figure 7-10), you can select which 
attributes will be used for computing the Aggregated Priorities. 

 
Figure 7-10 Load from Multiple Attributes – Select Attributes 

An example of the usefulness of this option is the following: you may 
want to combine sets of Objectives Benefits (priorities) that have been 
obtained at different moments in time or by different departments, for 
your new analysis.  
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Figure 7-11 Load from Multiple Attributes - Select Weights 

After setting the weights for each attribute that composes the aggregate 
priorities (Figure 7-11), click Next and the picture of all attributes in the 
selection will be displayed (Figure 7-12).  

Note: You can also set the range for the attributes to be used in this screen. 

 
Figure 7-12 Load from Multiple Attributes - Attributes List 

The next screen (Figure 7-13) presents the list of Aggregated Priorities 
that were computed using the selected attributes. 
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Figure 7-13 Load from Multiple Attributes - Aggregated Priorities 

Click Finish to apply them to your analysis.  

If you want to save the settings (the weight of each attribute) use the Save 
Template option, and they will be available for your next analysis. 

The Impact Matrix 

From the Optimizer Matrix Toolbar, clicking Next will take you to a page 
where the second matrix is loaded. It shows the Impact of the Projects on 
the Drivers.  

This matrix is not a systemic one (as was the case with the first one, 
assessing the Driver to Driver relative importance).   

Note: Also, it does not require all the values to be entered in order to allow you to 
proceed to the next step. 
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Figure 7-14 Optimizer Analysis - Projects/Drivers Matrix 

The options on the toolbar are the same as in the case of the first 
importance matrix – Drivers/Drivers Matrix.  

After completing the matrix, click Next and the application will compute 
the priorities for the projects that are being analyzed. 

Projects Weights Display  

The screen in Figure 7-15 displays the list of projects analyzed, with the 
related priorities for each one.  

Note: On the right, a chart graphically depicting the situation is shown. 
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Figure 7-15 Optimizer Analysis - Projects Ranking 

The options available on the toolbar are the same options presented when 
discussing the Business Objectives Priority Display earlier in this 
chapter. 

Clicking Next again will display the Weights Validation dialog - Figure 
7-16 - if there are any projects with the weights/priorities equal to 0.  

This check is done automatically by default, but it can be deactivated. 



Portfolio Optimization 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 66  
© Copyright 2006 United Management Technologies Inc. 

 

 
Figure 7-16 Projects Priorities - Validation 

To leave the entries with zero weight in your analysis, click OK. To 
remove them, click the mark besides each project in the What to do? list 
and it will change the mark’s color to red.  

If you want to remove them all click the Change All button and they will 
all become red. Then click OK and the projects with a red mark next to 
them will be removed from the analysis.  

Optimization Constraints 

After removing the entries that give you no benefit (if the priority is 0, 
then the entry has no impact on the company’s goals; therefore, it should 
only be left in the analysis if it is a project mandated by reasons other than 
business benefit – i.e. for legal or regulatory purposes), the constraints to 
be used in the analysis have to be loaded. 

The dialog that is displayed contains two lists (Figure 7-17). The one on 
the left is filled with the numeric (real or integer) structural attributes 
associated with the portfolio. Although all of them may be chosen, there’s 
no logic in loading an attribute like Priorities as your constraint.  

In order to use an attribute as a constraint in the analysis, select it from 
the list on the left and use the arrows to include it in the one on the right. 
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Always, the first constraint in the list on the right is called the primary 
constraint, while the others are called resource constraints.  

Note: The only difference between them is that the primary constraint comes first, 
and the scatter chart shown as part of your solutions uses the primary constraint on 
the 0x axis.  

 
Figure 7-17 Optimizer Analysis - Load Constraints 

After choosing which attributes will be used as constraints in your 
analysis, click OK. 
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Optimizer Solution  

The next screen displays solutions computed as part of the analysis. It is 
called the Optimizer Spreadsheet (Figure 7-18). 

The first column shows the identifiers of the entries in the projects 
structure (the ID of each structure entry). The next column shows the 
name of each entry, followed by the calculated weights (the rankings of 
each entry in your analysis as computed in the previous steps of the 
process) and then by the column(s) showing the constraints that were 
selected in the previous step.  

The values in the constraint column(s) are loaded from the Data View; at 
the bottom of each column the totals are computed, showing the value of 
the constraint for which all the projects in the analysis will be included in 
the solution. 

 
Figure 7-18 Optimizer Spreadsheet 
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In the right part of the screen, there is a scatter chart showing the projects 
that are included in the current analysis. The primary constraint (Cost in 
this example) will be displayed on the 0x axis while the Value (priority of 
the project) on the 0y axis.  

Note: When moving the mouse pointer over the scatter chart, details for each 
item on the graph are presented (each triangle in the scatter diagram represents a 
project). 

Working with a Solution Set 

On the last row of the sheet (bottom of the screen in Figure 7-18) you can 
see the Limit vector. Here you can type your own limitations 
(constraints), by double-clicking the cell and entering the desired value.  

Let’s say your primary constraint is the Cost of the projects. In our case, 
their total cost is 537,260. But you have a budget of only 300,000. To see 
the set of projects that provide the most value given the money constraint, 
type the 300,000 value in the Limit vector cell for Cost and click Next 
Step. The solution will be displayed as an additional column, in the same 
screen. 

 
Figure 7-19 Optimizer Spreadsheet - Solutions 
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The solution column (the next one after the constraints, to the right - 
Figure 7-19) shows you which projects you should implement to best 
meet the set of objectives.  

The entries (projects) that are in the current solution are marked with a 
green check mark (the ones that do not enter the solution are unmarked).  

At the bottom of this column you can see your total benefit in this 
situation. In our example, you have an 80.4811% benefit from your 
investment (the weights of the projects in the solution add up to 
80.4811%). 

In order to see the solution’s scatter chart, select the solution’s column by 
clicking it. The triangles representing the projects in the scatter chart 
(Figure 7-19) will change their color from blue to green or red (the ones 
that are included in the selected solution will become green, while the 
ones that are not included will be marked red). 

The box below the scatter chart shows how resources were used in the 
solution, and the total value of the solution. In this example, the box 
shows that you used almost all the money ($299,260 out of $300,000, 
which represents a usage of 99.753%), but could only use 179 out of 272 
available people. 

To calculate another solution, change the limit vector for one or more of 
the constraints and click Next Step again. This way you can see the 
possible solutions in varying scenarios.  

Note: You can calculate as many solutions as you like within an analysis. 

The Optimizer Toolbar 

 
Figure 7-20 Optimizer Spreadsheet Toolbar 

The only two new options that were not presented when speaking about 
the Optimizer Matrix Toolbar (section 13.4.2) are the Optimizer Menu 
and the Set Options menu. 
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The Optimizer Menu 

This menu displays a set of options that help you to better assess the 
results of your analysis. It also allows you to run more complex analyses 
on your set of data.  

There are two ways of entering the menu: the first is by right-clicking a 
solution; the second one is by using the Optimizer Menu button on the 
toolbar. Before clicking it, make sure you have selected a solution for your 
analysis (by clicking it).  

If there is no solution selected, some of the options will be disabled (save 
solution, advanced analysis). 

 

 
Figure 7-21 Optimizer Menu 
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Menu Item Description 

Solution Using the first option in the menu,  Solution, you 
can save the solutions that you calculate.  

 

Selecting Save... will save your solution for later 
use. When selected, a dialog box appears prompting 
you for the name of the solution; this name will be 
then displayed in the Optimizer Open Dialog, 
under Open Existing Solution tab. 

The second and third options – Save Entries In/Out 
of Solution as Filter – allow you to create filters 
with either the entries that were chosen or with the 
ones that were rejected after the optimization 
process was conducted.   Note: The filters will be 
available wherever they can be applied. 

The Load priorities from solution option loads the 
priorities from a previously saved solution. 

The Commit Scenario option is used to synchronize 
the results of the analysis with the UMT Portfolio 
Builder™: projects included in the solution will 
automatically be moved to the workflow step for 
selected projects. 

 Efficient 
Frontier 

The second option in the menu,  Efficient 
Frontier, will be presented separately later in this 
chapter. 
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Menu Item Description 

 Force In-Out. Next in the menu there is an option called  Force 
In-Out. If you choose to use it, you will be able to 
force a project to be included or excluded from the 
next solution without considering its impact on 
benefit or its effect on meeting constraints. 

 

By selecting Show Force In/Out Column a new 
column will be displayed to the left of the columns 
showing the constraints; for each structure entry 
there is a check-box that can have three colors: 
white, green and red.  

White for a structure entry means that it is left 
unchanged and the optimizer will choose if it is 
suitable to enter the solution or not.  

Green means that the entry is forced in and it will 
be included in the new solution automatically.  

Red means it will be excluded automatically.  

You can force in or out as many projects as you 
want.   

Note: This will not affect the already computed solutions. 

The next options in this menu allow you to load the 
forced in/out state of the entries from a solution 
that has already been generated, or from a saved 
attribute (as they can also be saved as a special 
structural attribute) and will appear in the Data 
view. 
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Menu Item Description 

You can also force in/out your entries by right-
clicking the triangles in the scatter chart and 
selecting force in or force out from the menu that 
appears. This operation only works at the analysis 
level. 

 Advanced 
Analysis. 

The next option displayed in this menu is  
Advanced Analysis. It will be discussed later in this 
chapter with the three options it provides (Insight, 
Sensitivity and Compute Drivers Cost). 

Constraints The fifth option,  Constraints, allows you to 
change the constraints that are used when 
computing the solution. Selecting this option will 
bring up the menu below. 

 

The first item in the list allows you to load the 
constraints used in a saved solution. 

The second option here does the same thing as the 
first one, but uses the saved Efficient Frontier as the 
source of data. 

The third option lets you load other attributes to be 
used as constraints for your analysis. When 
choosing it, a dialog box is presented, and you 
should choose the attributes keeping in mind the 
rules that are presented there. The values for the 
constraints that are used can be modified on the 



Portfolio Optimization 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 75  
© Copyright 2006 United Management Technologies Inc. 

 

Menu Item Description 
optimizer spreadsheet as it is not protected. It 
allows you to enter different values than the ones 
loaded. They will be used when computing the 
solution.  

The fourth option in this screen brings up the 
Optimize Distribution module, where more 
complex analyses can be developed. This module 
will be presented below. 

If you want the changed data to be available to you 
after you finish the optimization session, save them 
as a structural attribute using the fifth option in the 
menu – Save as attribute.  

Note: Make sure that you have selected the column 
containing those values first, by clicking its header.  

The last option in this menu is called Constraints 
Validation. If you select it, the application will 
display a message telling you if there are any null 
values for any of the constraints used in your 
analysis.  

 Display Next in the menu, the way the solutions are 
displayed (both in the spreadsheet and the scatter 
chart) can be changed. To do this, select the   
Display option. 

 

If the first option in this menu is selected, the entries 
that have been chosen as part of the solution (after 
the optimization process) will be highlighted.  The 
second option displays labels for the projects in the 
scatter chart. 
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Menu Item Description 

 Edit and 
Format 

The last option in the menu,  Edit and Format, 
applies to the optimizer spreadsheet only.  

Selecting it provides the following menu: 

 

The first two options allow you to copy a selection 
from the spreadsheet or the entire spreadsheet to 
the clipboard and paste them into an Excel 
worksheet. Using the last two, you can set the 
dimensions of the columns and rows in the 
spreadsheet. 

Optimize Distribution 

This section of the Portfolio Optimizer is used to create Proportional 
Solutions. These solutions differ from the regular ones that can be 
generated in the other modules (Optimizer Spreadsheet, Sensitivity 
Analysis) by the fact that they are computed with the goal of reducing the 
cost of the structure entries (projects) so that all of them can be 
undertaken, with a fixed budget.  

Unlike the regular (binary) solutions, which select the number of projects 
that best fit the organization’s goals (have the higher strategic value) for a 
given budget, the proportional solutions are optimizing and reducing the 
projects’ Cost (either real cost, or any other constraint – FTE, for example) 
in such a way that all projects in the portfolio can be undertaken with the 
same given budget. 

To proceed, choose the Optimize Distribution option from the Optimizer 
Menu – Constraints (Figure 7-21). The screen will bring up the setup 
dialog (Figure 7-22). 
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Figure 7-22 Optimize Distribution - Setup 

At the top of the screen, select the constraint to be optimized from the list 
of available constraints. Then, in the second pane, choose one of the 
options for the new solution you are generating (in the example in Figure 
7-22 there are no proportional solutions saved in this analysis, so only the 
first option makes sense).  

TIP: Regular (binary) and proportional solutions are not compatible, so the 
regular solutions will not appear in the Optimize Distribution dialog as available 
solutions on which proportional solutions can be generated. In the same way, 
the proportional solutions will not appear in the Optimizer Open dialog - 
Existing Solutions.  

After choosing New Solution, use the Next button to continue. 
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Figure 7-23 Optimize Distribution – Setting Target Budget 

In this step (Figure 7-23), the first thing that should be set is the Target 
cost (budget) that must be achieved. The variance of the target cost versus 
the total cost of projects is computed automatically.  

The following two sections refer to the algorithm used to reduce the cost 
(Value-cost dependency) and to the option of using Force In/Out settings 
for the projects making the object of the analysis.  

The last section of this screen – Source data for maximum constraints – 
presents a minimum value that can be taken by the total cost (this is set by 
default at 80% of the target total cost, but it can be changed by entering 
another value in that field).  

In addition, this section presents a selection list for the minimum cost, 
which can be loaded from one of the attributes associated with the 
portfolio. 
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Figure 7-24 Optimize Distribution – Solution Setup 

In the screen that follows (Figure 7-24), all the projects are listed. The 
options are to force them In or Out (using the same rules as for a regular 
solution – clicking the white marks until they become green for forcing in 
the project or red for forcing it out of the solution).  

Another option is to enter a value for the Minimum Cost, different from 
the value presented on the screen, as the Minimum Cost column is open 
for edit. In the next screen (Figure 7-25), the cost adjustment settings are 
presented. 
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Figure 7-25 Optimize Distribution - Cost Adjustment Setup 

First, cost can be adjusted by Priorities (the projects priorities loaded from 
the regular/binary solution in the Optimizer Spreadsheet) or by Bands.  

In the first case, a ratio between the project’s cost and priority is 
computed, and then the cost of each project is adjusted against the target 
cost value.  

If using the second option, Bands, the projects can be divided in three 
groups starting from top to bottom of the project list, sorted descending 
by priorities (bands), and a percentage of cost reduction can then be 
applied to each group, by entering the desired value in the appropriate 
field.  

Of course, for the third band the percentage is computed automatically, as 
the value left until the target cost is reached.  

The next screen presents the adjusted cost and priorities (Figure 7-26).  

For each project, the algorithm computes a new cost; all these costs, if 
added, will sum up to the target cost value (therefore all projects can be 
undertaken if their costs will be the new ones).  
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Figure 7-26 Optimize Distribution - Optimized Priorities 

After computing the new costs (which for some projects can be the same 
as the old ones), the application computes the adjusted priorities, using 
the linear model that was selected in the second section of Figure 7-23.  

The adjusted priority is computed according to the graph (drawn on a 
linear function) presented in the right side of the screen (Figure 7-26), 
when selecting a project in the list. 
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Figure 7-27 Optimize Distribution - Compare Solutions 

Using the Next option will present a screen (Figure 7-27) where the 
regular/binary solutions in the analysis are displayed, the last solution in 
the table being the proportional one, which has different values for the 
project’s costs and priorities than the binary ones. 

 
Figure 7-28 Optimize Distribution - Right Click Menu 

A right click in this screen will bring up a menu (Figure 7-28) which 
allows four operations.  

The first give the option of copying and pasting into excel a selection of 
the data on the screen or the entire sheet.  
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The third one allows you to save the proportional solution and it will be 
available to you at the next Optimize Distribution session in the analysis.  

The last one in the menu allows you to apply the adjusted cost and 
priority computed here to the binary solution (it will copy these values to 
the Optimizer Spreadsheet). 

 
Figure 7-29 Optimize Distribution - Efficient Frontier 

The final screen that is presented in this section (Figure 7-29) is an 
efficient frontier, which presents the regular/binary saved solutions and 
the proportional ones generated in this module, on the same graph. 

The Efficient Frontier 

The efficient frontier shows you the value of the best portfolio of projects 
(structure entries) at multiple constraint points (i.e. different costs). It can 
only be run with one constraint at a time.  For example, you can analyze 
Cost OR FTE, not both.  

To run an efficient frontier, select the option from the Optimizer Menu and 
Calculate Efficient Frontier.  

The dialog in Figure 7-30 is displayed: 
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Figure 7-30 Optimizer Analysis - Efficient Frontier Setup 

Select a constraint (attribute) to use, a minimum and a maximum value 
regarding that constraint and the number of points you want to see 
represented in the graph that will be displayed.  

Default values are 0 and the maximum value for the constraint (the sum 
of the values for all the structure entries in the analysis), and 11 data 
points.  

The number of points selected divides the interval represented by the 
range of the constraint (maximum value less the minimum one) into equal 
intervals of the constraint (Cost). 

After clicking OK, the efficient frontier will be generated in the right side of 
the screen, in the same place where the optimizer scatter chart appears 
(Figure 7-31). 
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Figure 7-31 Optimizer Analysis - Efficient Frontier 

Each point represents a portfolio of projects that best meets your 
objectives, taking into account your constraint. On the 0x axis the 
constraint that you selected in the setup step is displayed (e.g. Cost of the 
projects). The 0y axis shows the value of each portfolio. 

You can see the graph is in fact a curved line that flattens out as you 
invest more. In many cases, a good point to stop investing money is 
where this curve tends to go to the horizontal.  

Note: This point marks the point at which increasing your investment does not 
increase the value as much.  

If you use the arrows at the top of the window, a table will be displayed 
below the graph (Figure 7-31).  
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Here you can see details of the selected projects at each point (the points 
are placed at equal intervals on the 0x axis). You can move among 
portfolios (i.e. points) using the arrows at the top of Figure 7-31, and the 
details displayed will be updated for each position.  

A right-click in this table will open the submenu in Figure 7-32. 

 
Figure 7-32 Efficient Frontier - Right-Click Menu 

Menu Item Description 

 Save Efficient 
Frontier data as… 

To save all the portfolio results as an Excel 
worksheet, to further analyze it, use this option. An 
Excel save dialog appears and you can save the data 
locally. In the Excel worksheet, selected projects at 
each point are labeled 1; projects that are not 
selected are labeled 0. 

 Copy Efficient 
Frontier Data to 
Clipboard. 

To copy the information directly to the clipboard, 
use the second option. 

 Save point as 
filter option 

The last option allows you to save a point solution 
as filter for another analysis. There are two 
secondary options here: you can save the filter as 
either the Entries in Current Point or the Entries 
Out of Current Point. 

Advanced Analysis  

Advanced Analysis features are available in the Optimizer Menu, and 
they always apply to an existing solution. The three options provided in 
the menu (Figure 7-33) are Insight, Sensitivity and Compute Drivers 
Cost; each of them helps you to refine the solution obtained and, thus, to 
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be able to provide more accurate data and advice about the portfolio of 
projects. 

 
Figure 7-33 Optimizer Spreadsheet - Advanced Analysis 

Insight Analysis 

The impact of different constraints on a calculated solution is provided by 
Insight Analysis.  

It studies the impact that Dependencies, Alternatives, Force In/Out 
settings and Resource Constraints have on the solution and shows how 
the solution varies with each constraint.  

These different impacts are shown both on a bar chart representation and 
on a plot area; the different solutions are presented in relation with the 
efficient frontier. 

To load it, select the solution and choose  Insight Analysis from the 
Advanced Analysis submenu. The current solution is presented as a pink 
triangle (Figure 7-34) which moves within the area represented by the 
green lines when some (or all) of the impacts that may affect them 
(Dependencies, Alternatives, Forced In/Out projects, Resource 
constraints) are taken into account.  
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Figure 7-34 Advanced Analysis - Insight 

Each green mark represents one of the limit solutions (Min resource 
using solution or Max value solution). Right click each mark to display a 
menu that provides further information (Figure 7-35). 

 
Figure 7-35 Insight Analysis – Right Click Menus 

The first item in the menu identifies the position of the solution on the 

graph. Choosing the second one,  Show Solution Details brings up a 
new screen (Figure 7-36) with a more detailed view of the solution (see 
the example below for the Maximum value solution). 
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Figure 7-36 Insight Analysis - Solution Details 

Right click the grid to display a menu that allows you to sort the entries 
by their ID or by their Name, or to copy a selection of the grid or the 
entire grid to clipboard, and then paste them into an Excel worksheet. 

The next option in the Insight details menu is  Compare solutions. 
When selected, a new screen will display the four solutions (Min resource 
usage, Max value, Original and Current solutions) on the plot area for 
comparison - Figure 7-37.  
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Figure 7-37 Insight Analysis - Compare Solutions 

The entries colored with a green band have been included in more than 
two thirds of the solutions. These are projects that are viable under almost 
any condition.  

The yellow band shows projects that have been part of more than one 
third of the solutions, but less than two thirds. The projects colored with a 
red band are present in less than one third of the solutions. The same 
options on the right-click menu as in the case of the Solution Details 
screen are available. 

Each constraint you use in the Optimizer Analysis minimizes the value of 
the solution that could have been obtained by using only the hard 
constraint (most generally, the budget, thus the Cost constraint).  
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Each of the deviations from the optimal value, calculated only with the 
hard constraint, is shown in the bar chart representations on the 
Constraints Impact plot area. In Figure 7-34, such a graphical 
representation can be seen on the right side of the screen.  

As you can notice, the Force In/Out Impact provides an almost 10% drop 
in the value of the solution that could have been obtained using only the 
hard constraint solution. 

In the same way, the Resource constraints have a negative impact on the 
hard constraint solution (do not always expect the Total Bar to be the sum 
of the other impacts; it is not an error, but a feature of the mathematical 
algorithm behind this procedure). 

The Dependencies Impact will show you how using dependencies in 
your optimizer solution will affect the solution and how this varies if you 
remove the respective impact. In a similar manner, selecting or 
unselecting the checkbox can see the impact of Alternatives on your 
solution. 

The Force In/Out Impact can be further studied by clicking the Details 
button. This feature was designed to facilitate recalculating the Impact by 
forcing out projects that were forced in and analyzing the impact on the 
solution.  

The bar chart displayed (Figure 7-38) shows the impact of each project 
that was either Forced In or Out on the current solution. 
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Figure 7-38 Insight Analysis – Force In/Out Details 

Right click any of the project bars and a menu is displayed that allows 
you to select Auto (its initial state before having been forced in or out).  

Note: You can also switch the project back to its initial state.  

After any changes, you should click Apply, and a new solution will be 
computed and displayed on the plot area, indicated by a change in the 
position of the pink triangle representing the new solution.  

The File button displays the menu that allows you to save the bar chart as 
an Excel file or to print it. 

The Resource Constraints Impact will determine how the solution varies 
by using additional constraints – resource constraints. The bar chart 
displayed when clicking the Details button shows the impact of each 
resource constraint on the current solution.  

Note: Similar options as the ones for Force In/Out impacts are available. 
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Figure 7-39 Insight Analysis - Resource Constraints Impact 

Right click any of the resource constraints bars (in the example only FTE 
is present, but there can be more) to display a menu from which you can 
choose to ignore the constraint (the same way you can add it back).  

After any changes, you should click Apply, and a new solution will be 
computed and displayed on the plot area, by moving the pink triangle 
representing it accordingly.  This way you can see the impact of each of 
the resource (secondary) constraints on your solution. 

By unselecting all the checkboxes in the right side of the insight analysis 
screen (Figure 7-34), the position of the solution will be the highest 
possible, as the only thing that will have an impact upon it will be the hard 
constraint.  

TIP: The impact of these different constraints can be only studied in the case that 
you have actually used them when calculating the solution. Otherwise, obviously, 
the impact is zero and there is no graphical representation.  

The options of saving the graphs to Excel are provided for both the 
Efficient Frontier plot area and the Constraints Impact bar chart. To use 
them, click the File Menu button in the main insight window and select 
the chart you wish to use the options for. Other options here allow you to 
print or send them by e-mail. 
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There is another way of entering the insight analysis: from the optimizer 
open dialog, select the solution, select the insight analysis radio button and 
click Load. 

Sensitivity Analysis  

Sensitivity analysis allows you to change the drivers’ and projects’ 
weights used for calculating your solution so that you can assess how 
they will influence your solution, run different scenarios and compare the 
resulting solutions.  

Another feature is the In/Out Ranges which allows the user to see how 
the projects’ attributes should be changed so that the respective project 
will enter the solution (for projects that are not part of the solution) or 
how the total value of the attribute used as constraint should be modified 
so the project will be included in the solution. 

To load this type of advanced analysis, select the solution and choose  
Sensitivity Analysis (the second option in the Advanced Analysis 
menu). The main view (Figure 7-40) presented consists of the solution 
from the Optimizer, with the constraints used to calculate it. 

 The chart displayed is the same Optimizer Scatter Chart, where the 
solutions are represented on an X-Y axis, with the hard constraint on the X-
axis and the value (weight) on the Y-axis.  

File Menu options are available for both the Spreadsheet and the Chart 
and they allow you to save them as Excel files, print them or send them by 
e-mail.  
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Figure 7-40 Advanced Analysis - Sensitivity 

One of the most important features that is provided by sensitivity analysis 
is the ability to modify the weights used in the optimization process and 
thus obtain new solutions.  

You can find yourself in a situation where you decide to give a project a 
higher level of importance. To do this, you would generally have to run a 
completely new analysis.  However, by using sensitivity analysis, you 
simply modify the weight of the desired entry.  There is an additional 
advantage that you can also compare the solutions you have obtained by 
modifying the weights with the original solution created using the 
Optimizer. 

 To do this, click the Drivers or Projects button (depending on which 
structure you want to modify the weights of) and use the scales to 
increase or decrease the priorities of the desired projects or drivers - 
Figure 7-41 (the following example uses the Projects structure, but the 
dialog displayed is similar for both structures). 
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Figure 7-41 Sensitivity Analysis - Set Weights 

You can also load the weights from one of the real or integer structural 
attributes present in Data View. In order to do this, click the Load button 
and select the attribute that you want to use.  

After changing the weights, click Ok and a new solution is generated. It 
will be displayed as an additional column near the original solution that 
was loaded.  The column displaying the priorities and the scatter chart on 
the right side refer to the selected solution (which can be selected if you 
click its title).  

Note: This way, you can compare the result of changing the drivers’ or projects’ 
priorities on your portfolio by looking at the solutions. 

The red, yellow and green bands have the same meaning as in the Insight 
Analysis. They are meant to help you determine which projects are most 
likely to withstand the different changes that you make. A project on a 
green band signifies that in over two thirds of the cases, the project will 
enter the solution.  This tells you that in over 66% of the cases that you 
have analyzed, the respective project has entered the solution. 

The solutions that are generated using this option can be saved as 
solutions in the current analysis by clicking Save solution, or by using the 
option from the right-click menu.  
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Other options in this menu refer to the way solutions are displayed 
(highlighted or not) and to the possibility of copying a selection or the 
entire sheet to the clipboard (and paste it to Excel). 

If you want to include some of the projects that have been excluded by the 
optimizer algorithm in your solution, you have two options:  

1. To change the overall value of the constraint used (to increase 
your budget if the constraint used is cost); 

2. To diminish the value of the constraint for the project that was 
excluded (lower the cost of the project).  

Using the In/Out Ranges option, you can see exactly what the value of 
the constraint for your project should be and what value the limit vector 
(budget in our case) should have for that project to be included, keeping 
the weights of the project as they were computed by the optimizer.  

Click In/Out Ranges and the details will be presented in a new screen 
(Figure 7-42). 



Portfolio Optimization 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 98  
© Copyright 2006 United Management Technologies Inc. 

 

 
Figure 7-42 Sensitivity Analysis - In/Out Ranges Data 

The first column after the priorities displays the current values of the 
constraint, as used in the optimizer analysis (actually there are two columns 
under each of the three groups, Current Values, Portfolio Value and In 
Value, as two attributes were used in this analysis – Cost and FTE).  

The second group, Portfolio Values, shows the value of the limit vector 
for which the project will be included in your solution (actually, the total 
budget that you have to spend in order for that project to enter in the 
solution, when we speak about cost) – so that you know how much you 
should increase it. 

The third group of columns, In Values, shows you the maximum value of 
the constraint for your entry (project) necessary for it to be included in the 
solution. In this way, you know how much you have to reduce your costs 
(or other constraints) for the project to be part of the solution. 
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Using the right-click menu, you can save one of the columns as a 
structural attribute and it will be available for later analysis, or you can 
save a selection of the grid, or the entire grid, as an Excel file. 

To have a better image of these ranges, the application provides a bar 
chart in the same screen. You can access it by selecting the I/O Ranges 
Chart tab. 

 
Figure 7-43 Sensitivity Analysis - In/Out Ranges Chart 

This bar chart (Figure 7-43) shows all the projects in the solution, colored 
green if included in the solution or red if they are not part of the solution 
(they can be excluded due to constraints or force in/out settings).  

The size of the bars are according to the relative values of the projects’ 
benefit/cost ratios, as compared to the minimum of this ratio the project 
may have to be included in the solution.  
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The projects on the right side of the Y-axis should be included in the 
solution and the ones on the left should be excluded, if we take into 
account only the hard constraint. 

Note: By using this chart you can assess how much the constraint of the project 
(Cost or any other constraint used) should be reduced, in relative terms 
(percentage), in order for the project to be included in the solution. 

Compute Drivers Costs  

The last option in the Advanced Analysis menu is  Compute Drivers 
Costs. It calculates the cost for each entry in the Drivers structure, by 
allocating (dividing) the cost of projects according to the impact of each 
project entry on each driver entry.  

Select the solution for which you want to compute the drivers’ costs and 
choose the option from the Optimizer Menu/Advanced Analysis. 

 
Figure 7-44 Advanced Analysis - Driver Cost Setup 

The dialog that is displayed in Figure 7-44 lets you choose the structure 
for which the costs will be computed (there is more than one in the list 
only if you chose more than two structures when creating your analysis). 

 Choose the constraint (attribute) to be used as cost (you can also compute 
the resources cost by selecting FTE), and which projects should be 
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included – only the ones already in the solution, or all the projects in your 
analysis.  

After clicking OK, the screen shows a bar chart with two bars for each 
entry (Figure 7-45).  

 
Figure 7-45 Drivers Cost Chart 

One of them represents the relative cost of the driver, and the other its 
priority.  

Note: Using the Chart Menu option, you can save the analysis as an Excel file, 
print it, or send it by e-mail.  

To see the actual Drivers costs figures, select the second tab in this screen 
labeled Data (Figure 7-46). 
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Figure 7-46 Drivers Cost Data 

The first two columns present the drivers’ IDs and names.  

The third column presents the calculated Cost – absolute values, while the 
next one presents the Relative Costs for each entry.  

The last column shows the priorities. 

You can save the absolute or relative values of the cost as structural 
attributes, to be available for a later analysis, using the Save button. 

 Another option on this screen is Copy, available when using the button 
or by right-clicking. It allows you to copy a selection, or the entire grid, to 
the clipboard (and paste them into an Excel worksheet). 

Using the Optimizer for 
Application Portfolios 
The UMT Portfolio Optimizer™ module is also used to manage portfolios 
of Applications.  The Optimizer Steps outlined above are use to calculate 
metrics for the Business Importance and for the degree of Architectural Fit 
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of applications.  The Optimizer Solution features described above are not 
applicable to managing application portfolios. 

To use the Optimizer module for application portfolios, select 
Applications as the entity on the Optimizer Route Map page, and click on 
the yellow Application Valuation box. 

 

Figure 7-47 

Application Business Importance 

Applications can be prioritized using the same process described in the 
Error! Reference source not found. section Error! Reference source not 
found..  That would be a “two step” prioritization.  It is sometimes 
awkward to assess an application’s contribution to business drivers 
directly.  An alternative method, the “three step optimization”, uses a 
Process inventory to link applications to Business Drivers; this models 
reality. 

To create a three step optimization scenario, select that option on the 
Create New Analysis tab.  Specify the Step 3 matrix and filter the same 
way as Step two. 
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Figure 7-48 

The three step optimization requires that a Business Process inventory is 
created and linked to the Organization.  The Administrator can do this in 
the Settings tab of the UMT Portfolio Builder™.   

A three-step optimization consist of: 

• Pair-wise comparison among Business Drivers, the same as for 
project portfolio optimization 

• Contribution assessments of all Business Processes to Business 
Drivers 

• Contribution assessments of all applications to Business 
Processes – this can be done in an Optimizer step, or in the 
Process Impact tab for each application.   Save the priority values 
as optimizer variables, like “Business Importance”, for all 
applications. 

Note:  Contribution assessments of applications to Business Processes can 
be made in terms of percentage contributions, in lieu of Extreme, Strong, 
Moderate, Low and None choices.  This is sometimes preferable because 
most applications are in the “Low” range, which can be subdivided into 
several percentage choices for improved accuracy. 
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Architectural Fit 

The assessment of Architectural Fit is the same as other two step 
prioritization processes.  To initiate an Architectural Fit analysis, select 
“Prioritize Architecture Drivers” in the “Select Action” pull-down menu 
for Step 1 of an application prioritization. 

 

Figure 7-49 

An Architectural Fit analysis consists of: 

• Pair-wise comparison among Architecture Drivers, the same as 
the comparison of Business Drivers for project portfolio 
optimization 

• Fit assessments of all applications to Business Processes – this 
can be done in an Optimizer step, or in the Architectural Fit tab 
for each application.  Save the priority values as optimizer 
variables, like “Architectural Fit Score”, for all applications. 
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Optimizer Options  

There are several options that can be set for the analysis, either when 
creating it or at any step in the optimization process. If you want to set them 
at the beginning of the analysis, use the Options button in the Optimizer 
Open Dialog.  

If you decide to change them later in the optimization process, use the Set 
Options button on the optimizer toolbar. The dialog displayed is the same, 
wherever you access it from. 

  
Figure 7-50 Optimizer Analysis - Set Options 

Each of the options will be presented below, describing the result if it is 
checked: 

Check box Description 

Use force in/out 
settings 

Force In/Out constraints are taken into account 
when computing the solution. 

Use entries The dependencies between projects are taken into 



Portfolio Optimization 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 107  
© Copyright 2006 United Management Technologies Inc. 

 

Check box Description 
dependencies account when computing the solution. 

Use alternatives 
entries set 

The set of alternatives are taken into account when 
computing the solution. 

Display old 
frontiers 

If you have efficient frontiers in your analysis, they 
will all be displayed in the efficient frontier chart 
area. 

Display priorities 
as percent 

Shows the calculated priorities as percentages. 

Perform step 
validation 
automatically 

Performs step validation automatically – validates 
automatically the weights of the entries (tells you if 
any are equal to 0). 

Load relation 
matrix 
automatically 

Loads the Importance Matrix automatically. 

Save solution 
automatically 

Saves all generated solutions automatically. 

Use three step 
prioritization 

This enables an advanced, multi-tiered analysis 
designed for Application Portfolio Management 
assessments. 
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Optimizer Navigation  

The navigation between the optimizer steps can be done in two ways. 

1. The classic one, from one step to the next or previous one, using 
the Next Step and Previous Step buttons, placed in the top-
toolbar.  

2. The second one involves the use of the navigation selection box, 
which allows you to jump from one step to another without being 
forced to pass through the intermediate ones (Figure 7-51). 

 
Figure 7-51 Optimizer Analysis - Navigation 

As you can see, the steps available to you in the selection box are the two 
importance matrices, the lists of prioritized drivers and projects and the 
solutions page.  

Note: There is no restriction in this way of navigating (you can go either way, 
from any step to another).   

If you choose to skip a step when performing a new analysis, the 
optimizer will use the data that would load by default in the two 
matrices, in order to compute the priorities. 
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  CHAPTER 

8 

 

DECISION DASHBOARD 

General Overview 

The Decision Dashboard has been conceived out of the necessity for 
further analyzing portfolios of solutions that have been created in the 
Optimizer.  

Once you have decided on the optimal portfolio of projects, you can use 
Decision Dashboard to decide which of these projects you should start, 
and those that you will not be implementing.  

For this, a text type of attribute has been defined: Status. Besides this, the 
Decision Dashboard allows you to create several pie charts that let you 
see different subcategories of projects’ costs. 

Let us assume, for example, that you want to see how the costs of your 
projects are divided among divisions or among risk factors. You create a 
scenario in the Decision Dashboard and you will be able to see how 
much the projects that have been approved by different divisions will cost 
you.  

You can choose Division as an aggregating attribute, Cost as an 
aggregated attribute and see on the pie chart how the cost is divided 
among divisions.  

Key Concepts 

Here are some concepts that we will be operating with: 
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Aggregating attributes - these are text type attributes that group the 
projects from your portfolio solution into subsets, one subset for each 
distinct attribute value.  

Following the example above, one aggregating attribute could be 
Division, with the following values: Marketing, Finance, IT. If you use 
such an attribute as an aggregating attribute, you will have your projects 
grouped into three subcategories. 

Aggregated attributes - these are integer or real type attributes that reflect 
how much your projects cost. These attributes are calculated to show the 
sum of each project category. 

Status - the status attribute determines which projects enter the sum 
calculations that are performed to create the pie charts. The status 
attribute can take four possible values: 

 

Status Description. 

Go A project with a Go status is a definite resolution 
and will be included in the calculation. 

Kill A project with a Kill status will be excluded from 
the calculation. 

Hold A project on Hold is excluded from the current 
calculation, but requires further review. 

Blank / Null Blank / Null represents a project that still requires 
a decision.   

Creating a Scenario 

Click the Select button on the Optimizer toolbar (Figure 2-5). A dialog 
box similar to the one in Figure 8-1 will appear.  
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Figure 8-1 Decision Dashboard Setup 

A list of previously saved scenarios appears. You can either decide to run 
one of these scenarios, make changes to it, or create a new scenario.  

Note: The Delete option allows you to reduce the number of saved scenarios in 
the list.  

Click New to create a new scenario. The dialog in Figure 8-2 is displayed. 
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Figure 8-2 Decision Dashboard - Solution Selection 

Select the solutions you want to use by clicking their respective 
checkboxes. You can also choose one of the solutions as a Base solution.  

By selecting a solution in the respective menu, you will ensure that the 
projects you will be using are present in the solution.  

Furthermore, if an entry is not in the Base solution, it will not be shown 
in the list in the final page.  

Use the Next button to proceed to the next step. 
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Figure 8-3 Decision Dashboard – Filters Selection 

You may choose to use fewer entries than the actual solution has by 
applying a filter (checking the box next to it in the list in Figure 8-3).  

The filters are, of course, those previously defined for the respective 
structure in the Filter Wizard.  

You may select more than one filter, if necessary. Click Next to continue 
with the scenario setup. 
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Figure 8-4 Decision Dashboard - Attribute Selection 

You can select the structural attributes that you want to have displayed in 
the next menu. This can be done by checking the radio buttons for the 
attributes you want.  

Note: The attributes that you select here are also those that you will be using as 
aggregated attributes.  

You can decide to use either value from the structure, as defined in the 
Data View, or from the solution, in case you have modified some of the 
values while working with the Optimizer.  

Choose the number of decimals you wish to use. By default, this will be 
loaded from the value defined in Attribute Definition section.  

Use Next after making your selections. 
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Figure 8-5 Decision Dashboard - Select Initial Sorting 

You can choose to initially sort your list of projects either by the project’s 
name, its status or one of the structural attributes that you have selected 
in the previous step. This is done in the screen provided in Figure 8-5. 
Clicking Next will bring up the Pie Chart Setup screen - Figure 8-6. 

 
Figure 8-6 Decision Dashboard - Pie Chart Setup 
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In the next menu you can choose the aggregated and aggregating 
attributes (Figure 8-6). You have already selected your aggregated 
attributes.  

However, you may want to choose to use only some of them further in 
your scenario. This can be done in this step by clicking the check boxes for 
the attributes that you want to use.  

The Allocation by attributes is the aggregating attributes that you select 
from the text attributes associated to your portfolio. The Status attribute is 
checked by default and has to be used.  

Click Next after selecting the aggregated and aggregating attributes that 
will be used in the Decision Dashboard. 

 
Figure 8-7 Decision Dashboard – Default View 

The attributes you choose in the combo menu on this page (Figure 8-7) 
will be used when creating the pie charts and the portfolio radar charts.  

Note: You can choose the attributes that you want to use in the dropdown lists.  

These will be the default attributes. However, in the final step, you can 
change the aggregated or the aggregating attributes that create your pie 
chart.  
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The Portfolio Radar Chart represents the solutions’ positions on a 2 
attributes chart representing Impact on Operations versus Impact on 
Strategy. Here, you can select the integer or real attributes that you want 
to use as either impact.  

Most often, you would use Cost (or Cost-type attribute) as Impact on 
operations, which will be represented on the 0x axis, and a weight attribute 
as Impact on strategy, represented on the 0y axis.  

The Cost attribute that you can define here for the Portfolio Radar 
specifies minimum and maximum values for the Cost attribute, as well as 
the number of Cost points. It is similar in concept to the efficient frontier.  

Click Finish after making your choices and the Decision Dashboard view 
is displayed. 

The Decision Dashboard screen is divided into 2 panels:  

• One with the solutions in the portfolio, the projects and the 
structural attributes that are being used; 

• The other with the pie chart representations and the Portfolio 
Radar chart.  

We will discuss each of them separately. 

The left panel of the final screen looks similar to Figure 8-8, below. It is 
made up of several columns: 
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Figure 8-8 Decision Dashboard View 

Project list - this is the list of projects in the portfolio, as defined by the 
structure that you have chosen in an earlier step. 

Project status - you can decide here whether the projects in the structure 
will be taken into account for the calculation and graphical 
representation. The values this attribute can take have been discussed in 
the General Overview subchapter. 

Attribute columns - these columns show the values of the structural 
attributes that you have chosen. The values are read-only. Below the 
column title containing the attributes names, you will see the relevant 
values.  

Solutions columns - for each of the solutions that you have checked for 
use, a separate column is displayed. Your project can either be in the 
solution ( ) or out of the solution ( ).  

The projects, project status and attributes can be sorted ascending or 
descending if you click the project header.  

The right hand side panel is used for charts and graphical displays. It is 
comprised of two tabs: 
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• Allocation Chart tab, where the pie charts are displayed; 

• Strategy Radar tab, which displays a chart similar to the Efficient 
Frontier from the Optimizer. 

The Allocation Chart tab (Figure 8-9) displays in separate pie charts the 
Cost of each of your subsets of projects, as determined by the aggregating 
attributes. To select the aggregating attribute, click the combo box and 
select from the dropdown list.  

The attributes that you have here will be those that you have previously 
checked to be used in one of the previous steps of the scenario (Figure 
8-6). 

 
Figure 8-9 Decision Dashboard - Allocation Chart 

The Strategy Radar tab displays on a scatter chart the solutions that you 
have checked to be used, as well as the current solution that you have 
defined using Status attribute.  
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When you click the tab, you will also see a new row appearing in the left 
panel, as in the figure below.  

Thus, you can select the solutions that you want to see on your graph by 
checking the appropriate check boxes (Figure 8-10). 

 
Figure 8-10 Decision Dashboard - Solutions in the Strategy Radar 

The Current Status solution is represented as a green bubble, with the 
name Current and marked with the sum of the Cost attribute for all 
projects that have a Go status.  

The other solutions are represented as a green bubble marked with the 
solution name and the Cost attribute. 

On the 0x axis, you will have the Impact on Operations values, while on the 
0y axis, you have the Impact on Strategy values.  

You can either use the attributes that you have previously selected in the 
scenario wizard (by default) or you can select other attributes from the 
ones available in the dropdown list. 
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Figure 8-11 Decision Dashboard - Strategy Radar 

Using the Show Trends option, a dialog menu (Figure 8-12) will open, 
similar to the one for the Efficient Frontier in the Optimizer.  

You can select the number of points that you want to use, as well as the 
starting and ending limits. For each solution, a curve representing the 
variation of the solution point with the Cost attributes is composed.  

For each cost value in the predefined range, a new solution is calculated 
in the optimizer. The 0x and 0y points to represent the new solution are 
calculated by summing the projects entering the new solution point. 
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Figure 8-12 Decision Dashboard - Trend Setup 

The Decision Dashboard Toolbar 

The toolbar has a few basic options that come in handy when working 
with your scenario: 

The toolbar contains the following options: 

Button Description 

 

The Back to Setup button allows you to go back and 
redefine some of the variables in your scenario, such as 
your attributes. 

 

The Set status to advisory button can be used when 
first entering this screen. It calculates “advisory” 
values for your Status attribute, regardless of whether 
projects have been entered into the solution or not. It 
can be useful if you have a long list of projects and you 
want to have a preliminary idea on their status. 

 

The Save Scenario button allows you to save the 
scenario that you have created. You will find it in the 
first page of your setup wizard. 

 

This button Closes the Dashboard. No message dialog 
is displayed, so be sure to save all your scenario work 
before closing the Dashboard. 
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UTILITIES  

This section contains the following chapters: 

 Exporting Data 

 Importing Data 

 Chart Wizard 

 Portfolio Optimization 
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  CHAPTER 

9 

 

EXPORTING DATA  

In this chapter, you will learn how to export your data from the Portfolio 
Optimizer application to Microsoft Excel. You can save your data as a 
Microsoft Excel Workbook (*.xls) from: 

 The Data View 

 The Relations View 

 The UMT Optimizer™ analyzer 

The general export procedure applies to all the views and screens of the 
analyzer.  

General Data Export 
First, you have to click the File Menu button (Figure 9-1). 
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Figure 9-1 File Menu 

Then select  Save as… from the menu displayed. A dialog box will let 
you enter the file name; choose where to save the file and the file type.  

Choose Microsoft Excel Workbook (*.xls) if you want to export it to Excel, or 
Web Page (*.html), if you want the data saved in the HTML format. 

The menu is slightly different in the Optimizer. An Optimizer page may 
contain a chart in addition to a spreadsheet or matrix; therefore an 
intermediary step is required. By selecting the File Menu in the 
Optimizer, you will be presented with two options. 

The first option is dependent on the type of page you are in, either a 
spreadsheet or a matrix page. The second menu option is always Chart, it 
is only active if there is a chart displayed on that page. 

 
Figure 9-2 Spreadsheet/Matrix File Menu 

Select the option that best meets your needs and follow the steps defined 
above. 
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  CHAPTER 

10 

 

IMPORTING DATA 

The Import Data function allows you to transfer data from Microsoft Excel 
worksheets directly into the Portfolio Optimizer application (for 
example, if data has been sent to you in an Excel workbook, you can 
import it into a structure in the Data View).  

Note: The structure must have at least one entry and two levels.  

General Overview 

Data in the Microsoft Excel format can be imported into the UMT Portfolio 
Optimizer™. 

There are two types of data that can be imported: 

• Structure entries - structural attributes and their values. 

• Relations between structure entries, and their relational 
attributes. 

The first option is available when using the Import functionality from the 
List View or Data View to import the names, description, and structural 
attributes.  

The second option - importing relational attributes into Relations View – 
requires that you are in the Relations View and use Matrix Import.  

Regardless of what type of data you want to import, first you have to click 
the Import Wizard button on the toolbar.   
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The screens displayed after this action are different for each import type, 
so they will be treated separately in the following pages. 

Importing Structure Entries 

Click the Import Wizard button to go to a screen where you specify the 
location of the Excel file to be imported (Figure 10-1).  

This can be done either by manually inputting the path to the file, or by 
using the Browse option and selecting the file.  

From the same screen, you may select a template to be applied to the Excel 
sheet. A template allows you to reuse import settings that have been 
previously defined. 

 
Figure 10-1 Import Wizard - Select File 

Click the Next button at the bottom of your screen to move on (you can 
exit the Import Wizard at any time by pressing the Close button). The 
next screen will show a panel split in two.  
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Note: The top section presents the Excel worksheet you have selected for the 
import.  

Here, you should choose the specific rows (or group of cells) you want to 
import. If you want to import the entire document, select all cells (the 
selection is made the same way as in a Microsoft Excel worksheet). 

 
Figure 10-2 Import Wizard - Mapping Attributes 

Below the Excel worksheet, a radio button allows you to choose if the first 
row is a header row or not.  If Auto match is selected, the source column 
and Destination attribute will be automatically mapped (if the column 
heading and attribute name is exact).  The Separator selection will allow 
you to choose the Excel delimiter (, # ; /) 

Then, at the bottom part of the screen, the columns in the excel file have to 
be mapped against the existing attributes in the portfolio. This is done in 
two steps:  

1. First, the checkbox next to each column that has to be imported 
must be marked (left side in Figure 10-2), in order for that column 
to be imported.  

2. Then, in the second column – Destination Attribute, each 
checked column has to be mapped against one of the attributes in 
the drop-down list, and the values in the excel file will be 
imported as the values for that attribute. 
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You’ll see that the moment you select these rows, the Import range and 
the Import sheet will be completed by default. After performing these 
actions, you are ready to proceed to the next step (by clicking the Next 
button that has been activated).  

You can also go back a step by using Back, or exit the import session by 
using Close. 

When importing data, you may want to add new data, or overwrite 
existing data. The screen presented in Figure 10-3 allows you to set this 
option. If you want to update existing data, then the column and attribute 
used as the identifier should be selected.  

For example, if you want to update existing project data, then the 
identifier should be the Project Name.  The application will search for a 
project with the same name as the one to be imported, and it will update 
the data instead of creating a new project.  

After setting the option, click Next to proceed to the following step. 

 
Figure 10-3 Import Wizard - Select Import Type 

The final step of the Import Wizard is displayed. In this screen (Figure 
10-4), the final settings of the import session have to be completed. 



Importing Data 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 130  
© Copyright 2006 United Management Technologies Inc. 

 

 
Figure 10-4 Import Wizard - Final Step 

The screen shows the list of projects included in the import session, 
together with the attributes selected, just before they are imported/saved.  

The first column of the table contains check-boxes. If you don’t want some 
of the projects to be saved, uncheck the box next to them.  

The second column shows if the entry will be imported as a new project 
(N) or as an existing one to be updated (U). At the bottom part of the 
screen, a template with all the import settings can be saved and used for a 
later import session.  

Click Finish and the settings and imported data are saved, and the import 
session ends. You can find your saved import settings in the Based on 
section, at the beginning of each import session. 

 To quit the import session without saving any imported entries click the 
Close button. 
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Importing Relations Data 

In order to import matrix data, you have to be in the Relations View 
(Edit/Relations). 

From the Relations View, click the Import Wizard button, placed on the 
toolbar at the top of the screen, and a screen asking you to choose the file 
to import is displayed. 

Note: Not all Excel worksheets can be imported to the Relations View. They must 
have a structure similar to a matrix. 

The next window (Figure 10-5) shows you the sheet you’ve chosen to 
import and an Import Settings box: 

 
Figure 10-5 Import Matrix Wizard - Mapping Attributes 

First you must select the Relational Attribute for which the values will be 
imported, and then select the data range from the Excel worksheet in the 
first panel on the screen, as shown in Figure 10-5.  

The Import range and Import sheet values in the bottom view will be 
populated automatically. 
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Next, in the second panel, choose the key, or the Identification Type - this 
may be the Short Name of the entries, their Names or IDs. For example, 
let’s assume you’ve selected the Short Name option.  

Enter the drivers’ Short Name column from your Excel worksheet, shown 
at the top of the dialog box, and the projects’ Short Name row (also from 
your Excel worksheet).  

The import session cannot continue without this data (and the Next 
button will be disabled until all the required information is entered). The 
matrix you import can be normal or reversed, depending on the structure of 
your Portfolio optimizer matrix.  

Normal means the Excel data has the same rows and columns as the 
matrix loaded when you started the Import session (i.e. you should check 
reversed if the matrix presents the drivers and the projects in reverse order 
than the one you have in the Matrix/Relation View). 

You have one more option, Show empty cells. You will receive a warning 
about the fact that some cells are empty, and how many values (cells) 
were imported (Figure 10-6). 

 
Figure 10-6 Import Matrix Wizard - Report 

Click Next to bring up the validation screen, displayed if there are any 
problems with the entries. If not, the Import Wizard will not display it.  
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A value can be rejected for the following reasons: 

• The key cannot be found in the database. In this case, the entire 
row or column of the entry will be rejected;  

• Both keys (the one on the column and the one on the row) 
correspond to an entry that is not assigned to you. You can 
import only those values for which you own at least one entry; 

• The type of attribute isn’t consistent with the value being 
imported (i.e.: the Excel worksheet has real numbers and the 
Portfolio Optimizer expects a text attribute); 

• The imported value is out of the attribute’s definition range; 

• The text value of the entry does not match what Portfolio 
Optimizer is expecting (i.e. the value in the Excel worksheet is 
small but Portfolio Optimizer expects low, medium, or high). 

 
Figure 10-7 Import Matrix Wizard - Final Step 

The screen displayed in the last step of the import session (Figure 10-7) 
provides a clear picture of the import session, and allows several 
operations.  

To quit the import session without saving any imported entries click 
Close.  
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You can also save the import specifications for future use. This is done by 
entering a name for your import specification in the edit box at the bottom 
of the screen (default is New settings).  

To perform similar import sessions in the future, select the Save new 
template checkbox. You can find your saved import settings in the Based 
on section, at the beginning of each import session. 

Click Finish to save your changes and close the import session. 
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  CHAPTER 

11 

 

CHART WIZARD  

General Overview 

The Chart Wizard helps you create graphs that will enable you to 
visualize the relations between different structures, the structural 
attributes and their values, as well as more advanced analysis such as 
trend or aggregated charts.  

You can open the Chart Wizard by using the Chart View link in the 
toolbar at the top of the screen. This will open the dialog in Figure 11-1.  
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Figure 11-1 Chart Wizard Setup 

Let’s have a look at each of the chart wizard options presented here: 

• By using the Trend chart option, you can define and display 
charts representing the value of a project attribute in time. Each 
project has its own series and multiple projects can be 
represented. Each project may display a trend line relative to its 
series, however not all chart types allow this option. 

• Aggregated chart allows you to define and display charts of 
aggregated values of an integer/real attribute against values of an 
aggregating text attribute. 

• Divergence of Opinion Chart displays charts that show the 
different pair-wise comparison results that appear within an 
organization. 

• Generic Wizard Chart allows you to define charts to represent 
the values that your structural and relational attributes may take. 

• Manage Existing Charts - you can use this option to load charts 
that you have previously saved. 

Before further discussing the chart wizard options, we should first have a 
look at the different chart types one can use and how each of them 
matches the data that you want to see. 
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Chart Types 

The window below shows the different types of charts that you can use. 
As you can see in Figure 11-2, there are six chart types in total.  Each one 
will be explained in turn. 

 
Figure 11-2 Chart Wizard - Chart Type Selection 

Scatter Chart 

The Scatter Chart is a graphical representation of two attributes, on a 0x 
/0y -axis. You will generally be using this type of chart when you want to 
see how two structural attributes for the projects are represented. 

As an example, you can select weight and cost as the structural attributes 
and create a scatter chart that may look like the one below. On the 0x axis 
we have defined the cost attribute, while on the 0y axis, the weight 
attribute is used.  The graphic has four quadrants. This graphical display 
can be a powerful analysis tool. 
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The scatter chart (Figure 11-3) is a quick and simple way of gaining 
insight into the relationship between two structural attributes. 

 
Figure 11-3 Chart Wizard - Scatter Chart 

The options for a scatter chart are defined in the final window (Figure 
11-4) where you can set the chart title; select the 0x Axis Attribute and the 
0y Axis Attribute from the attribute list.  

Your choices will be displayed in the Axis Titles boxes in the upper-right 
of your window.  

Note: The structural attribute names are displayed by default; however you may 
change the values. 
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Figure 11-4 Chart Wizard - Scatter Chart Setup 

Bubble Chart 

The Bubble chart can be used when you want a graphical representation 
of three or four structural attributes. The first two attributes will be 
represented on the 0x and 0y-axis. The third attribute is represented as the 
bubble’s size, while the fourth one is the bubble’s color. 

A straightforward example of how a bubble chart can be useful is by 
selecting Cost, Priority, Status and Scaled Overall Risk as the structural 
attributes.   

The Cost and Priority attributes will be represented on the 0x and 0y-axis 
(as in the scatter chart example). The Status attribute will be used for the 
bubbles’ size, while Scaled Overall Risk will be set as the bubbles’ color. 
The figure below shows a sample outcome.    

The bubble chart has all the advantages of the scatter chart with the 
added value of representing additional data attributes on the chart. 
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Figure 11-5 Chart Wizard - Bubble Chart 

The options for a bubble chart can be seen in Figure 11-6, below. In the 
combo menus you can select the attributes that you want to use for each 
of the chart’s characteristics.  

The chart’s title and 0x/0y-axis titles are similar to the options described 
above for a scatter chart. Additionally, you can choose to represent your 
bubble size attribute either as the bubble’s diameter or as its area. 
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Figure 11-6 Chart Wizard - Bubble Chart Setup 

Pie Chart 

Let’s suppose that you have a total cost of your portfolio of projects and 
you want to see how much a single project costs, as compared to your 
total cost. A pie chart will display the cost of each project as slices of a pie 
(Figure 11-7).  
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Figure 11-7 Chart Wizard - Pie Chart 

The pie chart display options are set in two dialog boxes. In the first one 
(Figure 11-8), you can select your data labels, choose your chart to be 
Exploded into segments and turn Leader Lines on/off. 

.  

Figure 11-8 Chart Wizard - Pie Chart Setup (First Screen) 
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In the second dialog box (Figure 11-9), you can choose the attribute that 
you want to use for your pie chart and whether to display the legend or 
not.  

You can type a title for your chart (as for the other chart types described 
above) and you can select to use either Sort by Attribute or Summary 
Chart. 

If selected, the Sort by Attribute option will display all the projects’ 
values on the chart, sorting them in ascending or descending order.  

The Summary Chart option takes the smallest and largest values and 
divides the interval between them into four parts. The number of data 
points that fall within each interval is shown on the pie chart. 

 
Figure 11-9 Chart Wizard - Pie Chart Setup (Second Screen) 

Bar Chart 

A bar chart can be used when you want to compare values within a set or 
the sums of multiple sets. If you use only one attribute (cost, for example), 
your chart might look like the one in Figure 11-10.  
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Each cost is a subset of the maximum cost, in this case 320,000. A Bar 
Chart may be applied to more than one attribute.  

 
Figure 11-10 Chart Wizard - Bar Chart 

The Bar Chart options can be set in two dialog boxes. The first dialog - 
Figure 11-11 - allows you to choose the orientation of the bars: horizontal 
or vertical.  

The other option refers to the grouping/style of the attributes: 

• simple, used when you want to compare values within a set; 

• stacked, used to compare the sums of multiple sets; 

• stacked percent, used to compare relative weights within a set. 
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Figure 11-11 Chart Wizard - Bar Chart Setup (First Screen) 

In the second dialog (Figure 11-12) you have the standard options 
described previously: chart title, axis title, display legend and the choice 
between a summary chart and a standard chart.  

Additionally, for bar charts, spider charts and line charts you can choose 
the Data Series either as Attributes or as Entries. 

If you choose Entries, each project will be represented for each of the 
attributes that you have selected. You will thus have several bar charts, for 
each project.  

Note: By selecting Attributes you will see a graphical representation of each of 
your attributes.  
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Figure 11-12 Chart Wizard - Bar Chart Setup (Second Screen) 

Spider Chart 

A spider chart graphs multiple data sets on axes that are rays on a circle; 
it is useful when you have between 5 and 10 attribute types, usually 
numeric, and you want to compare only a few entries (up to about seven, 
but usually two or three is enough).  

Tip: Keep in mind that if you have more than one attribute on your spider chart 
the scale of the values should be similar.  Otherwise, some of your attributes may 
not be displayed correctly on the graph (for example, if you choose to see Cost, an 
attribute with high values, and Priority, which generally has values between 0 
and 1).  

The figure below shows a Spider chart for seven projects, reflecting the 
cost attribute. You can read on the rays the values that each project has.  
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Figure 11-13 Chart Wizard - Spider Chart 

You have two dialog boxes that you can use to set your spider chart 
options. In the first one (Figure 11-14), you can choose to see your data 
presented in:  

• lines, when your attribute values are represented as straight lines; 

• markers and lines, when the value for a project is also marked on 
the chart with a small dot; 

• filled, when the area covered on the circle is colored. 



Chart Wizard 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 148  
© Copyright 2006 United Management Technologies Inc. 

 

 
Figure 11-14 Chart Wizard - Spider Chart Setup (First Screen) 

The second dialog box (Figure 11-15) is the standard one for charts: the 
chart title, display legend and data series, which have all been discussed 
previously.  

 
Figure 11-15 Chart Wizard - Spider Chart Setup (Second Screen) 
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Line Chart 

A line chart is generally used when you want to see the trend of one or 
more data sets. By drawing a line chart, you will see the evolution of an 
attribute for each project.  

In the example in Figure 11-16, we have drawn a line chart for the cost 
attribute. The attribute evolves from lower values (Customer and Prospect 
Optimizer) to higher ones in the right hand side of the chart. 

 
Figure 11-16 Chart Wizard - Line Chart 

You have two dialog pages that you can use to set your line chart options. 
These have been largely explained in the bar and spider charts (see 
above).  

In the first dialog page (Figure 11-17), you have an additional option - 
Markers - that, if checked, allows you to display your data points on the 
final chart.  

If this option isn’t checked, the graph will show you one (or more) 
continuous lines, without data points.  
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Figure 11-17 Chart Wizard - Line Chart Setup (First Screen) 

The chart title, display legend and data series can all be completed in the 
second dialog page (Figure 11-18).  

 
Figure 11-18 Chart Wizard - Line Chart Setup (Second Screen) 
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Using Chart Wizard 

The section below will describe each of the available chart wizard options. 
This will include creating an aggregated chart, as well as a standard chart 
and a divergence of opinion chart. 

Trend Charts  

A trend chart can be very useful when you want to see the evolution of an 
attribute for a specific structure entry (driver or project) over a period of 
time.   

Note: For example, tracking project cost over a time period, or tracking the 
priority of a driver over time.   

In order to use this, select the Trend Chart option in the Chart Wizard 
Setup screen (Figure 11-1) and use the Next button to proceed to the next 
step (Figure 11-19). 

 
Figure 11-19 Chart Wizard - Trend Chart Setup 
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Trend charts can be generated both on structural attributes (the 
Spreadsheet radio button has to be selected) and relational attributes 
(Matrix has to be selected).  

In the current version of the UMT Portfolio Optimizer™ only the 
Spreadsheet ones are available. 

The next thing to do is to select the structure attributes to use (in this case 
IT Priorities for 2002, 2003 and 2004 are used, for Drivers structure). Then 
use the Next option and you are guided to the Filters Selection page 
common to all charts.  

After the filters, the following step asks you to choose the type of chart 
you want to generate (Figure 11-2).  

Note: For Trend Charts, only Bar, Spider and Line charts are available. 

Use next and the screen in Figure 11-20 is displayed. 

 
Figure 11-20 Chart Wizard - Trend Line Setup 

In this screen (Figure 11-20) the type of trend that will be computed and 
displayed has to be selected, together with the extrapolation period. The 
next two dialog boxes are specific options for each chart type. They have 
been described above.  
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Click Finish to draw your trend chart (Figure 11-21). The three points on 
the graph represent the value of the attributes (IT Priorities from 2002, 
2003 and 2004 for the “Increase number of new accounts” driver) and the line 
represents the trend for the next three values (possibly for the following 
three years). 

 
Figure 11-21 Chart Wizard - Trend Chart 

Aggregated Charts 

An aggregated chart will display aggregated values of an integer/real 
attribute against values of an aggregating text attribute. It means that your 
chart will group your entries (projects) according to the values of a text 
attribute (aggregating) and then apply an aggregating operator  (sum, 
average, max, min, count, standard deviation, variance or median) to 
entries having the same aggregating text value. 

Select the Aggregated Chart option in the setup screen, to begin (Figure 
11-1). After clicking Next you will see the Aggregate Chart Setup 
window (Figure 11-22). You can select: 

• The Structure combo menu - the structure that you want to 
display in the chart (Drivers or Projects); 
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• The Aggregated attribute - all integer or real type attributes in the 
structure will be displayed (more than one may be chosen); 

• The Aggregating attributes - all text type attributes from the 
structure will be listed, but only one of them may be chosen; 

• The Aggregating Function can be selected from a combo menu 
and contains the operators listed above. 

 
Figure 11-22 Chart Wizard - Aggregated Chart Setup 

Click Next after making your choices. The dialogs that follow are 
common for all charts and include the filter selection, chart type selection, 
as well as specific options for each chart type.  

After pressing Finish on the last stage, you will have an aggregated chart 
similar to the one in Figure 11-23. Each color of the pie represents one of 
the aggregating text attributes (scaled overall risk) values.  

The values shown beside the sectors are the totals of the aggregated 
attributes value (total cost of projects). 
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Figure 11-23 Chart Wizard - Aggregated Chart 

Divergence of Opinion Charts 

This feature takes into account the different pair-wise comparison results 
that may exist within an organization. The relationship between drivers 
and drivers or between drivers and projects, may be evaluated by 
different groups delivering different result sets.  

The Divergence of Opinion chart shows where these differences exist, 
and how different the opinions are. 

After choosing the Divergence of Opinion option in the setup menu 
(Figure 11-1), select the attributes you want to use by clicking the 
appropriate checkbox in the next screen presented (Figure 11-24).  

There are several other options that you can use in this page.  

1. You can choose to include fewer entries in your chart by selecting 
a filter from the combo menu. The bar chart is the only available 
chart.  

You will see the specific options for this type of chart: orientation, 
3D and the option to include or exclude blank entries.  
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2. The second chart option window is standard for all charts and has 
been discussed previously. 

 
Figure 11-24 Chart Wizard - Divergence of Opinion Chart Setup 

Generic Chart Wizard 

Most of the options for the generic chart wizard (filter selection and chart 
types) have been discussed already. However, we should mention the 
attributes and structure selection dialog window, shown in Figure 11-25. 

When using the Generic Chart Wizard, you first choose a Base View; 
either a Data View (the entries in only one structure will be represented 
on the chart), or a Relations View, when relational attributes between 
two structures will be displayed. Click the appropriate radio button to 
make your choice. 

If you have selected Data View, you will be able to select one of the 
structures (drivers or projects) and then select the appropriate attributes to 
be used in the chart. All structural attributes from the respective structure 
will be displayed. 
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The Relations View option will let you select the two structures from the 
menu, as well as the relational attributes that have been defined in 
Structure and Relations Definition.  

The rest of the windows are standard for all chart types. 

 
Figure 11-25 Chart Wizard - Base View Selection 

Management of Existing Charts 

This option allows you to load charts that have been saved previously. In 
the combo menu next to this option, you have a list of all of the charts that 
have been saved in the portfolio.  

You can load your saved chart in two ways: 

• Load with Original Data allows you to load the chart that you 
have saved without any possible changes that you may have 
made in the Chart Wizard (changing attributes, filters, etc.); 

• Load with Actual Data will incorporate any changes that may 
have been made since the chart was last generated. 



Chart Wizard 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 158  
© Copyright 2006 United Management Technologies Inc. 

 

Chart Display 

This is actually the final step of your wizard, where you can actually see 
the chart that you have drawn and where your data is displayed. The 
chart display is divided into two parts: the chart area and the chart display 
toolbar, shown at the top of Figure 11-26. 

 
Figure 11-26 Chart Display – Actions Panel 

The chart area is where your chart is drawn. The toolbar (Figure 11-27) 
offers several options: 

 
Figure 11-27 Chart Display Toolbar 
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Item Description 

 

The File Menu provides basic options such as 
saving your chart to an Excel worksheet, Print, 
Page Setup and Print Preview. 

 

The Back to Wizard option allows you to go 
back to the Chart Wizard and modify some of 
the parameters that you have used. You can 
thus create a new chart with different 
parameters. 

 

The Details button will display a dropdown 
menu such as the one below. This will let you 
toggle between the chart area and the chart 
data that you have used (that can also be seen 
in an Excel worksheet).  

On a scatter or bubble chart (generally on 
charts using X/Y axis), you also have the 
possibility of choosing to see one of the 4 
quadrants that make up the chart area. 

 

 

The Actions button displays a panel on the 
right hand side of the chart area that lists the 
attributes used for the creating charts and 
enables changing the major chart options such 



Chart Wizard 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 160  
© Copyright 2006 United Management Technologies Inc. 

 

as X/Y axis scales, legend and labels text size. 

The panel is shown on the right side of Figure 
11-26. 

 

The Save button lets you save the chart that 
you have drawn. The chart will be listed as a 
pre-saved chart in the combo menu presented 
in the first page of the Chart Wizard and can 
be loaded for further analysis.  

 

The Close button will end your Chart Wizard 
session. 
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  CHAPTER 

12 

 

FILTER MANAGEMENT 

General Overview 

The UMT Portfolio Optimizer™ provides flexible filtering functionalities.  
Filters are used to select subsets of structures, e.g. Projects, Applications, 
Business Drivers, for analysis during portfolio optimization sessions.  

The UMT Portfolio Optimizer™ allows the definition and use of several 
types of filters: Project filters, Programs filters, Applications filters, 
Business Drivers filters, Business Processes filters, and Architecture 
Drivers filters. 

While each of the above six structures that the UMT Portfolio Optimizer™ 
works with can be filtered, a filter can only be defined for a single 
structure – i.e. a filter that applies to both projects and business drivers for 
instance cannot be defined.  

Filters are best defined and managed thru the Filter Management function 
accessed from the Settings feature of the UMT Portfolio Manager™. Please 
refer to the Settings Guide. For convenience, each filter type can also be 
defined and managed in the UMT Portfolio Optimizer™: List, Edit and 
Relations views, as well as the Chart wizard. 

Filters can be applied, but cannot be defined or managed in the initial 
Analyzer view that is used for analysis purposes. 

The Filter Management functionalities accessible from within the UMT 
Portfolio Optimizer™ include: 
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• Define: The Filter Wizard provides the ability to define, modify, 
and save new filters. 

• Manage: The Filters Menu provides the ability to apply, clear, 
delete, and view filter definitions. 

The steps detailed in the following sections are for filters based on 
Projects. The same steps apply to create and manage filters based on the 
other structures that are used for portfolio optimization. 

Define Filters 

The Filter Wizard enables defining new filters.  To access the wizard, 
select the Define New Filter… option from the Filters Menu button 
(Figure 12-1). This button is accessible from the List, Edit and Relations  
views.  

 
Figure 12-1 Filter Menu 

Note: The Filter menu accessible from the List view does not include the options 
Clear all filters and Active filters....  

To create a new Project filter, click the Define New Filter… option from 
the Filters Menu button displayed in the Project Definition view toolbar. 

Alternately, click the Filter Wizard button in the second screen of the 
Chart Wizard. The pop-up window in Figure 12-2 appears, with the 
Projects filter type already preselected: 
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. 

 
Figure 12-2 Filter Wizard - Select Filter Type 

The preselected structure in the Filter Wizard Select Filter Type dialog is 
the one that was selected as the primary structure in the List, Edit or 
Relations view that was displayed at the time you selected the Define 
New Filter… option from the Filters Menu button. 

Click the Next button to proceed, or click Close Window  to exit the filter 
management dialog box without saving any changes.  

The Filter Functional Type menu provides the ability to choose the 
functional type of filter: 

• Projects, e.g. Structure name – if you check this option, you can 
manually select the structure entries that the filter will select. This 
is a static filter based on the structure entry IDs. 

• Structural Attribute – the structural attribute values will be the 
criteria used to select the entries. This is a dynamic filter based on 
the value of each structure entry attribute. 

Filters based on Structures 

After you click Next in the dialog box (Figure 12-2) presented above, a 
new window appears (Figure 12-3): 
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Figure 12-3 Filters Setup - Projects 

The list on the right side, Available Projects,  shows all projects in the 
organization level or existing custom portfolio selected thru the two 
respective drop down menus 

Select project entries to include in the filter by clicking the project name 
from the Available Projects list, and then adding it to the Project in Filter 
list on the left side of the screen.  

• To add a project into the Project in Filter list, click the arrow 
pointing to the right. 

• To add all the projects into the Project in Filter list, click the 
double arrow pointing to the right. 

The same logic applies for removing entries from the filter: 

• To remove an entry from the Project in Filter list, select its name 
in the left side list and click the arrow pointing to the left. 

• To remove all entries from the Project in Filter list, click the 
double arrow pointing to the left.  

Filters based on Attributes 

If attributes are chosen as the filtering criteria, the dialog box in Figure 
12-4 will appear: 
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Figure 12-4 Filters Setup – Structural Attributes 

To create an attribute filter, follow the steps below: 

• Select the Attribute from the drop-down list. All defined 
attributes related to the chosen structure for the portfolio 
analyzed will be available.  For Projects, the four mandatory 
attributes Start Date, End Date, Fixed Start Date, and Fixed End 
Date will be available at minimum. 

• Define the condition that has to be met by the attribute value in 
relation to the test value 

• Enter the test value for testing the structural attribute against the 
defined condition  

• Define the logical operation between that attribute condition and 
the attribute condition listed on the next line (if more than one 
attribute condition is in the list)  

The selections available for creating the attribute filter are detailed below: 

• Attribute: Click the Attribute drop-down menu button and select 
the name of the structural attribute to be tested by the condition 

• Condition: Click the drop-down menu button and select the 
condition that the structural attribute must meet for the Project or 
Competency entry  to be included in the filter results: 

Condition Description 

“=” Equal The value of the structural attribute for the 
tested entry must be Equal to the test value set 
in the value cell (Numeric, Date or Text value). 

“<>” Different The value of the structural attribute for the 
tested entry must be Different from the value 
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Condition Description 
set in the value cell (Numeric or Text value). 

“>” Greater 
than 

The value of the structural attribute for the 
tested entry must be Greater than the value set 
in the value cell (Numeric or Date value). 

“<” Less than The value of the structural attribute for the 
tested entry must be Less than the value set in 
the value cell (Numeric or Date value). 

“>=” Greater 
than or equal 

The value of the structural attribute for the 
tested entry must be Greater than or Equal to the 
value set in the value cell (Numeric or Date 
value). 

“<=” Less 
than or equal 

The value of the structural attribute for the 
tested entry must be Less than or Equal to the 
value set in the value cell (Numeric or Date 
value). 

“Is empty” The structural attribute must have no defined 
value. 

“Is not empty” The structural attribute must have any defined 
value. 

 

• Value: Enter the test value for testing the structural attribute 
against the defined condition: 

Value Description 

Value • For text attributes select the values from 
the list  that appears. 

• For date attributes select the values from 
the calendar that appears. 

• For numeric and string attributes type in 
the test value. 

 

• Operator: Specifies how the stated attribute condition should be 
combined with other attribute conditions within the filter: 
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Operator Description 

And The filter will only include entries that meet 
both attribute conditions - the one with the 
And operation and the one after it. 

Or  The filter will include entries that meet 
either this attribute condition or the next 
condition.  

End  Indicates that this is the last condition. This 
option is included for clarity only. The filter 
will automatically stop at the last condition 
regardless of the operation specified for it. 

Note: The And operation takes precedence over the Or operation when 
the conditions are evaluated. 

Seelct an operator and click on the Add Condition button to enter a new 
attribute and attribute condition, as necessary. 

To delete the last condition, click the Erase Condition button. 

Save Filters 

When you are done defining the filter, click on the Next button. 

At this point the Save dialog box asking for a filter name, if the filter is 
public or private and a description appears (Error! Reference source not 
found.).  
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Figure 12-5 Filters - Save Dialog 

A private filter is only available to you, while a public filter will become 
available to all users. Click on Finish button to save the filter just defined. 

At any time, clicking on the Back button will send you back to the 
previous screen of the wizard.  

Clicking the Cancel or Close Window button in any of the Filter Wizard 
dialog boxes will result in the filter not being saved. 

Manage Filters 

Deleting an Existing Filter 

The Filters menu also provides the ability to delete existing filters.  
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Figure 12-6 Filters Management 

Select the filter in the selection box and choose Delete filter from the 
Filters Menu. The operation must be confirmed before the filter is 
deleted. 

Apply Filter 

To apply a filter, select it from the drop-down list and then click the 
Apply Filter option in the Filters Menu (Error! Reference source not 
found.). Projects or Competencies will be filtered using the criteria set in 
the filter definition. 

The UMT Portfolio Planner™ provides the ability to successively apply 
several filters, one after the other, on the same structure.  

To apply a second filter, repeat the operation to apply the filter. To see the 
list of filters applied on Projects or Competencies, select the last option 
from the Filters Menu (Figure 12-6), Active Filters. 

Note: In any Data Entry view, the filters applied on a structure remain in effect 
after the Save Data operation. 
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Clear Filter 

To clear one or all of the filters applied on a structure, choose one of the 
following options in the Filters Menu: 

• Clear filter: Clears the filter selected in the box 

• Clear all filters: Clears all applied filters on the selected structure 

These operations will not delete the filters (and will be available in the 
selection box), but will simply “un-filter” the structure entries for the 
current session. 

View Filter 

The View Filter option in the Filters Menu allows read only access to the 
definition of the selected filter.  

To use this option, select the filter to view from the filter drop-down list 
and choose View Filter from the menu. 

 
Figure 12-7 Filter - View 

Note: Filters on this screen (Error! Reference source not found.) cannot be 
modified. 

The Preview Filter allows you to preview the results, i.e. the list of the 
projects or competemcies, that the filter will return. 
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Click on the Close button if you want to review another filter definition. 
The list of available filters will be displayed. Select the one you would like 
to review and click on the View button. The window as in Figure 12-7 
will be displayed. 

Click on the Close Window button when you have completed your filter 
review. 
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  APPENDIX 

A 
 

 

APPENDIX 

Installation and Setup 

Browser Configuration 

UMT Application requires that browser settings be set at their default 
values.  

Before you start using the UMT Portfolio Manager Application, you must 
make sure that some options in your browser are set to their default 
values. The following two sections provide default browser settings for IE 
4.x and IE 5.x, respectively.  

Internet Explorer 5.x settings 
To set the Internet Explorer 5.x settings, follow the next steps: 

1. On the main menu click Tools and select Internet Options; 
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Figure 13-1 

2. Click the Security tab from the window that appears; 

 

Figure 13-2 

3. Select the Internet zone; 

4. Choose Custom Level; 

5. In the window that appears set the following options to Enable: 
• Download signed ActiveX controls; 
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• Run ActiveX controls and plug-ins; 
• Script ActiveX controls marked safe for scripting; 
• Allow cookies that are stored on your computer; 
• Submit non-encrypted form data; 
• Active X scripting. 

Excel Configuration 

This section describes the configuration of Microsoft Excel for the UMT 
Portfolio Optimizer™. 

To set the Microsoft Excel settings, follow the next steps: 

• On the main menu click Tools and select Options; 

 

Figure 13-3 
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• The next window will appear: 

 

Figure 13-4 

• Click the Security tab; 

• Click the Macro Security button. The security dialog box will 
appear: 

 

Figure 13-5 

• Click the Trusted Publishers tab; 
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• Ensure that the Trust access to Visual Basic Project box is selected. 
If the box is not selected, you will get error messages when using 
certain functions within the Portfolio Optimizer™. 

Example: 

When trying to use certain functions in the UMT Portfolio 
Optimizer™, the next error message will be displayed: 

 
Figure 13-6 

Technical Requirements and 
Recommendations 
The following are hardware and software requirements and 
recommendations for optimal performance. 

Software & System Standards 

• Application Web Server: Microsoft Internet Information Server (IIS) 
5.x, 6.x 

• Application Server OS: Windows 2000 Server, Windows 2003 Server   

• Application Server additional requirements: Microsoft .NET 
Framework 1.0 or 1.1, SoftwareFX ChartFX (ChartFX is included with 
UMT software suite) 

• Database Server RDMS: Microsoft SQL Server 2000 (32 Bit) 

• Reporting: Microsoft SQL Reporting Services 
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• Programming Platform/Language: Microsoft ASP.NET / C#, C++ 

• Email Server Integration: Email notifications and alerts sent from 
UMT Portfolio Manager™ via SMTP Gateway 

• Single sign-on utilizing Microsoft Active Directory: UMT Portfolio 
Manager™ provides for user authentication using MS Active 
Directory if desired. 

• Document Management: The UMT Portfolio Manager™ has a built-in 
Document Management system.  Integration with other 3rd party 
document management systems can be performed as a customization 
effort. 

• Portfolio Manager™ has pre-built connectors into MS Excel (version 
2000 or newer), MS Windows Sharepoint Services 2003, MS Project 
(version 2000 or newer) and MS Project Server (version 2003). 

• Client Financial Systems / General Ledger Integration: UMT has built  
client-specific interfaces into General Ledger / ERP systems,  
including SAP and PeopleSoft 

Hardware & Software Recommendations 

The following recommendations are based on 50 concurrent users. 

Application Platform Specifications 

Application Hardware 

(If Licensee is installing 
and hosting UMT 
Software in Licensee’s 
data center) 

UMT Recommended System Hardware 
Configuration: 

• Application Server and Web Server on a 
single dedicated Windows server. 

• Database Server on a single dedicated 
Windows server. 

 

Dedicated Windows servers as described above 
should have the following minimum 



Appendix 

 
UMT Portfolio Optimizer™ 3.3 – User Manual 178  
© Copyright 2006 United Management Technologies Inc. 

 

specifications: 

• Dual 2.4 GHz Pentium IV Processor class 
machine with: 

- 2 GB RAM 

- 300MB disk space for the application 

- Database size according to scale of 
installation (typically, 500MB) 

 

UMT recommends both a Production and a Test 
environment based upon the above dedicated 
server specifications. 

 

A typical client Production server hardware 
configuration is provided below.  An identical 
Test environment hardware configuration is also 
recommended based on the same hardware 
configuration. 

• 1 Application Server (Dual Pentium 4 
machine, 2GB RAM, Windows 2003 Server)  

• 1 Database Server ( Dual Pentium 4 machine, 
2G RAM, Windows 2003 Server, MS SQL 
Server 2000) 

Application Operating 
System and Utilities (If 
Licensee is installing and 
hosting UMT Software 
in Licensee’s data center) 

• Presentation Server: Microsoft Internet 
Information Server (IIS) 5.x, 6.x  

• Application Server OS: Windows 2000 
Server, Windows 2003 Server   

• Application Server: Microsoft .NET 
Framework 1.0 or 1.1, SoftwareFX ChartFX 

• Database Server RDMS: Microsoft SQL 
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Server 2000 (32 Bit) 

Client Desktop Environment  

Client Operating System 
• Microsoft Windows 2000, or Microsoft 

Windows XP 

Client Software 
• Client Browser: Microsoft IE 5.5 SP2 or 6x  

(for users who are provided with access to 
the UMT Portfolio Optimizer™ and the UMT 
Portfolio Planner™ modules, IE must be 
configured to accept signed ActiveX controls, 
which are used for complex data entry, 
reporting, analysis, and charting in the UMT 
Portfolio Optimizer™ and UMT Portfolio 
Planner™ modules.  The ActiveX controls 
are signed with a UMT digital certificate, 
issued by Verisign Inc.) 

• Client Desktop Software Requirement: 
Microsoft Excel 2000 or higher (For Excel 
2002 (XP) “Trust access to Visual Basic 
Project” should be enabled, disabled by 
default.). If Microsoft Project integration is 
used, the Microsoft Project Client software 
must be installed (2000 or higher). 

o Note: UMT Portfolio Manager™ has 
pre-built connectors into MS Excel 
and MS Project for import/export. 

Development/Testing/Staging Environments 

See Application Platform Specifications above.  

Network & Communications Requirements 

Client PCs must have Intranet / Internet connectivity over corporate LAN 
to UMT Portfolio Manager™ server.  To the extent required, UMT 
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Portfolio Manager™ software suite may require connectivity to any 
external business applications that the UMT Portfolio Manager™ 
software suite may be importing (exporting) data from on a periodic 
basis. 

Integration with other Applications 

Microsoft Index Server The UMT Portfolio Manager™ uses the MS 
Index Server to perform full text searches into 
the stored documents, as a feature of the 
Document Management module. The Index 
Server should be able to index files from the 
UMT Portfolio Manager™ storage folder. The 
recommended setup is:  

• The document storage folder should be 
setup on either the Application or the 
Database servers 

• The Index Server should be installed on 
the Database server and a linked server 
should be used to access the indexed 
data. 

Microsoft Project Server The UMT Portfolio Manager™ uses Microsoft 
Project Server to import, export and 
synchronize schedule and resource data 
between the two applications. The MS Project 
Server requires additional configuration in 
order to work with UMT Portfolio Manager™ 
(a PDS extender file must exist on the server 
side). Also, if working with resource data, an 
Analysis Server must be setup as a source for 
data import (either using an MS Olap Cube or a 
linked MS SQL Server). Since both types of 
authentication are supported (Windows 
integrated and user/password based), there is 
no constraint on the installation domain for any 
of the servers. 

Microsoft Sharepoint The UMT Portfolio Manager™ can use MS 
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Server Sharepoint Server to store documents and to 
access Issues lists by linking specific entities 
(project, application, program or organization) 
to Sharepoint sites. There is no additional setup 
required for the MS Sharepoint Server. 
However, the UMT Portfolio Manager™ must 
be able to use Windows authentication to 
connect with the MS Sharepoint Server. 

Microsoft SQL Reporting 
Services 

The UMT Portfolio Manager™ uses Microsoft 
Reporting Services to display complex data 
reports. The MS Reporting Server requires 
additional setup in order to work with UMT 
Portfolio Manager™. The MS Reporting Server 
should be able to access UMT Database server 
in order to gather the data needed for the 
report display. 
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LINDO Systems, Inc. 
UMT Portfolio Manager incorporates LINDO API © 2004-2006 by LINDO 
Systems, Inc.  All rights reserved. 

Ease-of-use, complete coverage of problem types, reliability, and speed 
and have made LINDO Systems a leading supplier of software tools for 
building and solving optimization models. LINDO Systems’ linear, 
nonlinear, integer and global solvers have been used by thousands of 
companies worldwide to maximize profit or minimize cost on decisions 
involving production planning, transportation, finance, portfolio 
allocation, capital budgeting, auction solving,  blending, scheduling, 
inventory, resource allocation, product design, and more. For more 
information on LINDO Systems and its products go to www.lindo.com. 
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